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hardware, drivers, and/or software to take full
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drive to install the Windows 7 software and
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About This Book
WARNING! Text set off in this manner indicates that failure to follow directions could result in bodily harm
or loss of life.
CAUTION: Text set off in this manner indicates that failure to follow directions could result in damage to
equipment or loss of information.
NOTE: Text set off in this manner provides important supplemental information.
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Product features

Standard configuration features
Features may vary depending on the model. For a complete listing of the hardware and software installed in
the computer, run the diagnostic utility (included on some computer models only).
NOTE: This computer model can be used in a tower orientation or a desktop orientation.

Standard configuration features
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Front panel components
Drive configuration may vary by model. Some models have a bezel blank covering one or more drive bays.

1

Slim Optical Drive (optional)

5

Headphone Connector

2

USB 2.0 Ports (black)

6

Dual-State Power Button

3

USB 3.0 Ports (blue)

7

Hard Drive Activity Light

4

Microphone Connector

8

3.5-inch Media Card Reader (optional)

NOTE: The Power On Light is normally white when the power is on. If it is flashing red, there is a problem with the
computer and it is displaying a diagnostic code. Refer to the Maintenance and Service Guide to interpret the code.
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Rear panel components

1

PS/2 Mouse Connector (green)

6

Power Cord Connector

2

RJ-45 Network Connector

7

PS/2 Keyboard Connector (purple)

3

Serial Connector

8

DisplayPort Monitor Connector

4

USB 2.0 Ports (black)

9

VGA Monitor Connector

5

Line-In Audio Connector (blue)

10

Line-Out Connector for powered audio
devices (green)

NOTE:

An optional second serial port and an optional parallel port are available from HP.

When a graphics card is installed in one of the system board slots, the video connectors on the graphics card and the
integrated graphics on the system board may be used at the same time. However, for such a configuration, only the display
connected to the discrete graphics card will display POST messages.
The system board graphics can be disabled by changing settings in Computer Setup.

Rear panel components

3

Serial number location
Each computer has a unique serial number and a product ID number that are located on the exterior of the
computer. Keep these numbers available for use when contacting customer service for assistance.
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Illustrated parts catalog

Computer major components
This chapter provides part information for all chassis.

Item

Description

(1)

Front bezel

(2)

Access panel

(3)

Power supply
240W, 85% efficient
240W, standard

Computer major components
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Item

Description

(4)

System board (includes replacement thermal material)
For use in models without Windows 8
For use in models with Windows 8 Standard
For use in models with Windows 8 Professional
For use in models with NetClone (the People’s Republic of China only)
Memory modules (PC3,12800, CL11)
8-GB
4-GB
2-GB
Processors (include replacement thermal material)
Intel Core i7 4790 (3.6-GHz, 8-MB L3 cache), 84W
Intel Core i7 4790s (3.2-GHz, 8-MB L3 cache), 65W
Intel Core i7 4771 (3.5-GHz, 8-MB L3 cache), 84W
Intel Core i7 4770 (3.4-GHz, 8-MB L3 cache), 84W
Intel Core i7 4770s (3.1-GHz, 8-MB L3 cache), 65W
Intel Core i5 4690 (3.5-GHz, 6-MB L3 cache), 84W
Intel Core i5 4690s (3.2-GHz, 6-MB L3 cache), 65W
Intel Core i5 4670 (3.4-GHz, 6-MB L3 cache), 84W
Intel Core i5 4670s (3.1-GHz, 6-MB L3 cache), 65W
Intel Core i5 4590 (3.3-GHz, 6-MB L3 cache), 84W
Intel Core i5 4590s (3.0-GHz, 6-MB L3 cache), 65W
Intel Core i5 4570 (3.2-GHz, 6-MB L3 cache), 84W
Intel Core i5 4570s (2.9-GHz, 6-MB L3 cache), 65W
Intel Core i5 4430 (3.0-GHz, 6-MB L3 cache), 84W
Intel Core i5 4430s (2.7-GHz, 6-MB L3 cache), 65W
Intel Core i3 4370 (3.8-GHz, 4-MB L3 cache), 54W
Intel Core i3 4360 (3.7-GHz, 4-MB L3 cache), 54W
Intel Core i3 4350 (3.6-GHz, 4-MB L3 cache), 54W
Intel Core i3 4340 (3.6-GHz, 4-MB L3 cache), 54W
Intel Core i3 4330 (3.5-GHz, 4-MB L3 cache), 54W
Intel Core i3 4160 (3.6-GHz, 4-MB L3 cache), 54W
Intel Core i3 4150 (3.5-GHz, 4-MB L3 cache), 54W
Intel Core i3 4130 (3.4-GHz, 4-MB L3 cache), 54W
Intel Pentium G3460 (3.5-GHz, 3-MB L3 cache), 53W
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Item

Description
Intel Pentium G3450 (3.4-GHz, 3-MB L3 cache), 54W
Intel Pentium G3440 (3.3-GHz, 3-MB L3 cache), 54W
Intel Pentium G3430 (3.3-GHz, 3-MB L3 cache), 54W
Intel Pentium G3420 (3.2-GHz, 3-MB L3 cache), 54W
Intel Pentium G3250 (3.2-GHz, 3-MB L3 cache), 53W
Intel Pentium G3240 (3.1-GHz, 3-MB L3 cache), 54W
Intel Pentium G3220 (3.0-GHz, 3-MB L3 cache), 54W
Intel Celeron G1850 (2.9-GHz, 2-MB L3 cache)
Intel Celeron G1840 (2.8-GHz, 2-MB L3 cache)

Cables

Item

Description

(1)

Front I/O assembly

(2)

Power switch assembly
SATA drive power cable
SATA data cable, 19.5 inch, 2 straight ends
SATA data cable, 14.0 inch, 1 straight end, 1 right angle
DMS-59 to dual VGA cable
DMS-59 to dual DVI cable
Adapter, DisplayPort to VGA
Adapter, DisplayPort to DVI
Adapter, DisplayPort to HDMI
Adapter, DVI to VGA
Adapter, DVI-I to VGA (BFR/PVC free)
Adapter, DVI-I to VGA (Standard)
DisplayPort cable

Cables
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Misc parts

Item

Description

(1)

Fan sink (includes replacement thermal material)

(2)

Speaker

(3)

Printer port, PCI card

(4)

Fan duct

(5)

Serial port, PCI card
Card reader, 14-in-1, USB 3.0, 3.5-inch
Card reader, 15-in-1, USB 3.0, 3.5-inch, UHS-II
Adapter, USB 3.0 to 2.0
Optical drive bezel blank
Grommet, hard drive
HP Ultraslim Keyed Cable Lock
Clamp lock, universal cable, without plate
Chassis stand
Hard drive carrier, 2.5-inch to 3.5-inch
WLAN antennas
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Item

Description
Mouse
PS2, optical
USB, HP Elite
Washable
HP USB Antimicrobial
USB, optical
Keyboard
PS/2
USB
Wireless, HP Elite with USB dongle (for use only in Brazil)
Unbranded
USB, unbranded, Katydid
Smart card, CCID
Wireless keyboard, mouse, and dongle kit (for use in all countries except for Brazil)
Washable
HP USB Antimicrobial

Drives
Description
Hard drive
2 TB, 7200 rpm, 3.5 inch
1 TB, 10000 rpm
1 TB, 7200 rpm, 3.5 inch
1 TB hard drive, hybrid SSD
500 GB, 10000 rpm
500 GB, 7200 rpm, 2.5 inch
500 GB, 7200 rpm, 2.5 inch, self-encrypting (SED)
500 GB, 5400 rpm, 2.5 inch, FIPS
500 GB hard drive, hybrid SSD
256-GB Solid-state Drive (SSD), self-encrypting (SED)
256-GB Solid-state Drive (SSD)
180-GB Solid-state Drive (SSD), MLC
128-GB Solid-state Drive (SSD)

Drives
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Description
128-GB Solid-state Drive (SSD), self-encrypting (SED)
120-GB Solid-state Drive (SSD), MLC
32-GB Solid-state Drive (SSD), 2.5 inch, MLC
Optical drive
Blu-ray BD-RW SuperMulti XL Drive
DVD±RW drive
DVD-ROM drive

NOTE: 2.5-inch solid-state drives require an adapter for installation.

Misc boards
Description
Nvidia NVS310 PCIe x16 graphics card, 512 MB
Nvidia NVS315 PCIe x16 graphics card, 1 GB
AMD Radeon HD8490 DP PCIe x16 graphics card, 1 GB
AMD Radeon HD8450 PCIe x16 graphics card, 1 GB
AMD Radeon HD8350 DH PCIe x16 graphics card, 1 GB DDR3
Intel PRO/1000 single port GbE NIC, includes bracket
Intel 802.11 a/b/g/n + Bluetooth 4.0 Wireless NIC
Intel Dual Band Wireless-N 7260 802.11 a/b/g/n (2x2) Wireless NIC
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Routine care, SATA drive guidelines, and
disassembly preparation
This chapter provides general service information for the computer. Adherence to the procedures and
precautions described in this chapter is essential for proper service.
CAUTION: When the computer is plugged into an AC power source, voltage is always applied to the system
board. You must disconnect the power cord from the power source before opening the computer to prevent
system board or component damage.

Electrostatic discharge information
A sudden discharge of static electricity from your finger or other conductor can destroy static-sensitive
devices or microcircuitry. Often the spark is neither felt nor heard, but damage occurs. An electronic device
exposed to electrostatic discharge (ESD) may not appear to be affected at all and can work perfectly
throughout a normal cycle. The device may function normally for a while, but it has been degraded in the
internal layers, reducing its life expectancy.
Networks built into many integrated circuits provide some protection, but in many cases, the discharge
contains enough power to alter device parameters or melt silicon junctions.

Electrostatic discharge information
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Generating static
The following table shows that:
●

Different activities generate different amounts of static electricity.

●

Static electricity increases as humidity decreases.
Relative Humidity

Event

55%

40%

10%

Walking across carpet

7,500 V

15,000 V

35,000 V

Walking across vinyl floor

3,000 V

5,000 V

12,000 V

Motions of bench worker

400 V

800 V

6,000 V

Removing DIPs from plastic tube

400 V

700 V

2,000 V

Removing DIPs from vinyl tray

2,000 V

4,000 V

11,500 V

Removing DIPs from Styrofoam

3,500 V

5,000 V

14,500 V

Removing bubble pack from PCB

7,000 V

20,000 V

26,500 V

Packing PCBs in foam-lined box

5,000 V

11,000 V

21,000 V

These are then multi-packaged inside plastic tubes, trays, or Styrofoam.

NOTE: 700 volts can degrade a product.

Preventing electrostatic damage to equipment
Many electronic components are sensitive to ESD. Circuitry design and structure determine the degree of
sensitivity. The following packaging and grounding precautions are necessary to prevent damage to electric
components and accessories.
●

To avoid hand contact, transport products in static-safe containers such as tubes, bags, or boxes.

●

Protect all electrostatic parts and assemblies with conductive or approved containers or packaging.

●

Keep electrostatic sensitive parts in their containers until they arrive at static-free stations.

●

Place items on a grounded surface before removing them from their container.

●

Always be properly grounded when touching a sensitive component or assembly.

●

Avoid contact with pins, leads, or circuitry.

●

Place reusable electrostatic-sensitive parts from assemblies in protective packaging or conductive
foam.

Personal grounding methods and equipment
Use the following equipment to prevent static electricity damage to equipment:
●

12

Wrist straps are flexible straps with a maximum of one-megohm ± 10% resistance in the ground cords.
To provide proper ground, a strap must be worn snug against bare skin. The ground cord must be
connected and fit snugly into the banana plug connector on the grounding mat or workstation.
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●

Heel straps/Toe straps/Boot straps can be used at standing workstations and are compatible with
most types of shoes or boots. On conductive floors or dissipative floor mats, use them on both feet with
a maximum of one-megohm ± 10% resistance between the operator and ground.
Static Shielding Protection Levels
Method

Voltage

Antistatic plastic

1,500

Carbon-loaded plastic

7,500

Metallized laminate

15,000

Grounding the work area
To prevent static damage at the work area, use the following precautions:
●

Cover the work surface with approved static-dissipative material. Provide a wrist strap connected to the
work surface and properly grounded tools and equipment.

●

Use static-dissipative mats, foot straps, or air ionizers to give added protection.

●

Handle electrostatic sensitive components, parts, and assemblies by the case or PCB laminate. Handle
them only at static-free work areas.

●

Turn off power and input signals before inserting and removing connectors or test equipment.

●

Use fixtures made of static-safe materials when fixtures must directly contact dissipative surfaces.

●

Keep work area free of nonconductive materials such as ordinary plastic assembly aids and Styrofoam.

●

Use field service tools, such as cutters, screwdrivers, and vacuums, that are conductive.

Recommended materials and equipment
Materials and equipment that are recommended for use in preventing static electricity include:
●

Antistatic tape

●

Antistatic smocks, aprons, or sleeve protectors

●

Conductive bins and other assembly or soldering aids

●

Conductive foam

●

Conductive tabletop workstations with ground cord of one-megohm +/- 10% resistance

●

Static-dissipative table or floor mats with hard tie to ground

●

Field service kits

●

Static awareness labels

●

Wrist straps and footwear straps providing one-megohm +/- 10% resistance

●

Material handling packages

●

Conductive plastic bags

●

Conductive plastic tubes

●

Conductive tote boxes

●

Opaque shielding bags

Electrostatic discharge information
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●

Transparent metallized shielding bags

●

Transparent shielding tubes

Operating guidelines
To prevent overheating and to help prolong the life of the computer:
●

Keep the computer away from excessive moisture, direct sunlight, and extremes of heat and cold.

●

Operate the computer on a sturdy, level surface. Leave a 10.2-cm (4-inch) clearance on all vented sides
of the computer and above the monitor to permit the required airflow.

●

Never restrict the airflow into the computer by blocking any vents or air intakes. Do not place the
keyboard, with the keyboard feet down, directly against the front of the desktop unit as this also
restricts airflow.

●

Occasionally clean the air vents on all vented sides of the computer. Lint, dust, and other foreign matter
can block the vents and limit the airflow. Be sure to unplug the computer before cleaning the air vents.

●

Never operate the computer with the cover or side panel removed.

●

Do not stack computers on top of each other or place computers so near each other that they are
subject to each other’s re-circulated or preheated air.

●

If the computer is to be operated within a separate enclosure, intake and exhaust ventilation must be
provided on the enclosure, and the same operating guidelines listed above will still apply.

●

Keep liquids away from the computer and keyboard.

●

Never cover the ventilation slots on the monitor with any type of material.

●

Install or enable power management functions of the operating system or other software, including
sleep states.

Routine care
General cleaning safety precautions
1.

Never use solvents or flammable solutions to clean the computer.

2.

Never immerse any parts in water or cleaning solutions; apply any liquids to a clean cloth and then use
the cloth on the component.

3.

Always unplug the computer when cleaning with liquids or damp cloths.

4.

Always unplug the computer before cleaning the keyboard, mouse, or air vents.

5.

Disconnect the keyboard before cleaning it.

6.

Wear safety glasses equipped with side shields when cleaning the keyboard.

Cleaning the Computer Case
Follow all safety precautions in General cleaning safety precautions on page 14 before cleaning the
computer.

14
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To clean the computer case, follow the procedures described below:
●

To remove light stains or dirt, use plain water with a clean, lint-free cloth or swab.

●

For stronger stains, use a mild dishwashing liquid diluted with water. Rinse well by wiping it with a cloth
or swab dampened with clear water.

●

For stubborn stains, use isopropyl (rubbing) alcohol. No rinsing is needed as the alcohol will evaporate
quickly and not leave a residue.

●

After cleaning, always wipe the unit with a clean, lint-free cloth.

●

Occasionally clean the air vents on the computer. Lint and other foreign matter can block the vents and
limit the airflow.

Cleaning the keyboard
Follow all safety precautions in General cleaning safety precautions on page 14 before cleaning the
keyboard.
To clean the tops of the keys or the keyboard body, follow the procedures described in Cleaning the
Computer Case on page 14.
When cleaning debris from under the keys, review all rules in General cleaning safety precautions on page 14
before following these procedures:
CAUTION: Use safety glasses equipped with side shields before attempting to clean debris from under the
keys.
●

Visible debris underneath or between the keys may be removed by vacuuming or shaking.

●

Canned, pressurized air may be used to clean debris from under the keys. Caution should be used as too
much air pressure can dislodge lubricants applied under the wide keys.

●

If you remove a key, use a specially designed key puller to prevent damage to the keys. This tool is
available through many electronic supply outlets.
CAUTION: Never remove a wide leveled key (like the space bar) from the keyboard. If these keys are
improperly removed or installed, the keyboard may not function properly.

●

Cleaning under a key may be done with a swab moistened with isopropyl alcohol and squeezed out. Be
careful not to wipe away lubricants necessary for proper key functions. Use tweezers to remove any
fibers or dirt in confined areas. Allow the parts to air dry before reassembly.

Cleaning the monitor
●

Wipe the monitor screen with a clean cloth moistened with water or with a towelette designed for
cleaning monitors. Do not use sprays or aerosols directly on the screen; the liquid may seep into the
housing and damage a component. Never use solvents or flammable liquids on the monitor.

●

To clean the monitor body follow the procedures in Cleaning the Computer Case on page 14.

Cleaning the mouse
Before cleaning the mouse, ensure that the power to the computer is turned off.
●

Clean the mouse ball by first removing the retaining plate and the ball from the housing. Pull out any
debris from the ball socket and wipe the ball with a clean, dry cloth before reassembly.

●

To clean the mouse body, follow the procedures in Cleaning the Computer Case on page 14.

Routine care
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Service considerations
Listed below are some of the considerations that you should keep in mind during the disassembly and
assembly of the computer.

Power supply fan
The power supply fan is a variable-speed fan based on the temperature in the power supply.
CAUTION: The cooling fan is always on when the computer is in the “On” mode. The cooling fan is off when
the computer is in “Standby,” “Suspend,” or “Off” modes.
You must disconnect the power cord from the power source before opening the computer to prevent system
board or component damage.

Tools and software Requirements
To service the computer, you need the following:
●

Torx T-15 screwdriver

●

Torx T-15 screwdriver with small diameter shank (for certain front bezel removal)

●

Flat-bladed screwdriver (may sometimes be used in place of the Torx screwdriver)

●

Phillips #2 screwdriver

●

Diagnostics software

●

Tamper-resistant T-15 wrench

Screws
The screws used in the computer are not interchangeable. They may have standard or metric threads and
may be of different lengths. If an incorrect screw is used during the reassembly process, it can damage the
unit. HP strongly recommends that all screws removed during disassembly be kept with the part that was
removed, then returned to their proper locations.
CAUTION: Metric screws have a black finish. U.S. screws have a silver finish and are used on hard drives
only.
CAUTION: As each subassembly is removed from the computer, it should be placed away from the work
area to prevent damage.

Cables and connectors
Most cables used throughout the unit are flat, flexible cables. These cables must be handled with care to
avoid damage. Apply only the tension required to seat or unseat the cables during insertion or removal from
the connector. Handle cables by the connector whenever possible. In all cases, avoid bending or twisting the
cables, and ensure that the cables are routed in such a way that they cannot be caught or snagged by parts
being removed or replaced.
CAUTION: When servicing this computer, ensure that cables are placed in their proper location during the
reassembly process. Improper cable placement can damage the computer.
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Hard Drives
Handle hard drives as delicate, precision components, avoiding all physical shock and vibration. This applies
to failed drives as well as replacement spares.
●

If a drive must be mailed, place the drive in a bubble-pack mailer or other suitable protective packaging
and label the package “Fragile: Handle With Care.”

●

Do not remove hard drives from the shipping package for storage. Keep hard drives in their protective
packaging until they are actually mounted in the CPU.

●

Avoid dropping drives from any height onto any surface.

●

If you are inserting or removing a hard drive, turn off the computer. Do not remove a hard drive while
the computer is on or in standby mode.

●

Before handling a drive, ensure that you are discharged of static electricity. While handling a drive,
avoid touching the connector.

●

Do not use excessive force when inserting a drive.

●

Avoid exposing a hard drive to liquids, temperature extremes, or products that have magnetic fields
such as monitors or speakers.

Lithium coin cell battery
The battery that comes with the computer provides power to the real-time clock and has a minimum lifetime
of about three years.
See the appropriate removal and replacement chapter for the chassis you are working on in this guide for
instructions on the replacement procedures.
WARNING! This computer contains a lithium battery. There is a risk of fire and chemical burn if the battery
is handled improperly. Do not disassemble, crush, puncture, short external contacts, dispose in water or fire,
or expose it to temperatures higher than 140ºF (60ºC). Do not attempt to recharge the battery.
NOTE: Batteries, battery packs, and accumulators should not be disposed of together with the general
household waste. In order to forward them to recycling or proper disposal, please use the public collection
system or return them to HP, their authorized partners, or their agents.

SATA hard drives
Serial ATA Hard Drive Characteristics
Number of pins/conductors in data cable

7/7

Number of pins in power cable
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Maximum data cable length

39.37 in (100 cm)

Data interface voltage differential

400-700 mV

Drive voltages

3.3 V, 5 V, 12 V

Jumpers for configuring drive

N/A

Data transfer rate

6.0 Gb/s

SATA hard drives
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SATA hard drive cables
SATA data cable
Always use an HP approved SATA 6.0 Gb/s cable as it is fully backwards compatible with the SATA 1.5 Gb/s
drives.
Current HP desktop products ship with SATA 6.0 Gb/s hard drives.
SATA data cables are susceptible to damage if overflexed. Never crease a SATA data cable and never bend it
tighter than a 30 mm (1.18 in) radius.
The SATA data cable is a thin, 7-pin cable designed to transmit data for only a single drive.

SMART ATA drives
The Self Monitoring Analysis and Recording Technology (SMART) ATA drives for the HP Personal Computers
have built-in drive failure prediction that warns the user or network administrator of an impending failure or
crash of the hard drive. The SMART drive tracks fault prediction and failure indication parameters such as
reallocated sector count, spin retry count, and calibration retry count. If the drive determines that a failure is
imminent, it generates a fault alert.

Cable management
Always follow good cable management practices when working inside the computer.
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●

Keep cables away from major heat sources like the heat sink.

●

Do not jam cables on top of expansion cards or memory modules. Printed circuit cards like these are not
designed to take excessive pressure on them.

●

Keep cables clear of sliding or moveable parts to prevent them from being cut or crimped when the
parts are moved.

●

When folding a flat ribbon cable, never fold to a sharp crease. Sharp creases may damage the wires.

●

Some flat ribbon cables come prefolded. Never change the folds on these cables.

●

Do not bend any cable sharply. A sharp bend can break the internal wires.

●

Never bend a SATA data cable tighter than a 30 mm (1.18 in) radius.

●

Never crease a SATA data cable.

●

Do not rely on components like the drive cage, power supply, or computer cover to push cables down
into the chassis. Always position the cables to lay properly by themselves.

Chapter 3 Routine care, SATA drive guidelines, and disassembly preparation
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Removal and replacement procedures:
Small Form Factor
Adherence to the procedures and precautions described in this chapter is essential for proper service. After
completing all necessary removal and replacement procedures, run the Diagnostics utility to verify that all
components operate properly.
NOTE: Not all features listed in this guide are available on all computers.

Preparation for disassembly
See Routine care, SATA drive guidelines, and disassembly preparation on page 11 for initial safety
procedures.
1.

Remove/disengage any security devices that prohibit opening the computer.

2.

Remove all removable media, such as compact discs or USB flash drives, from the computer.

3.

Turn off the computer properly through the operating system, then turn off any external devices.

4.

Disconnect the power cord from the power outlet and disconnect any external devices.
CAUTION:

Turn off the computer before disconnecting any cables.

Regardless of the power-on state, voltage is always present on the system board as long as the system
is plugged into an active AC outlet. In some systems the cooling fan is on even when the computer is in
the “Standby,” or “Suspend” modes. The power cord should always be disconnected before servicing a
unit.
5.

If the computer is on a stand, remove the computer from the stand and lay the computer down.
NOTE: During disassembly, label each cable as you remove it, noting its position and routing. Keep all
screws with the units removed.

Preparation for disassembly
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Access panel
1.

Prepare the computer for disassembly (Preparation for disassembly on page 19).

2.

Loosen the thumbscrew on the rear of the computer (1) then slide the panel back (2) and lift if off the
computer (3).

To install the access panel, reverse the removal procedure.
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Front bezel
1.

Prepare the computer for disassembly (Preparation for disassembly on page 19).

2.

Remove the access panel (Access panel on page 20).

3.

Lift up the three tabs on the side of the bezel (1), then rotate the bezel off the chassis (2).

To install the front bezel, reverse the removal procedure.

Front bezel
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Front bezel security
The front bezel can be locked in place by installing a security screw provided by HP. To install the security
screw:
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1.

Prepare the computer for disassembly (Preparation for disassembly on page 19).

2.

Remove the access panel (Access panel on page 20).

3.

Remove one of the five silver 6-32 standard screws located on top of the drive cage.

4.

Install the security screw through the middle front bezel release tab to secure the front bezel in place.
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Bezel blanks
On some models, there are bezel blanks covering the 3.5-inch and 5.25-inch external drive bays that need to
be removed before installing a drive. To remove a bezel blank:
1.

Remove the access panel (Access panel on page 20).

2.

Remove the front bezel (Front bezel on page 21).

3.

To remove a slim optical drive bezel blank, press inward on the five retaining tabs (1) and pull the blank
off the front bezel (2).
To remove a 3.5-inch bezel blank, press the two retaining tabs that hold the bezel blank in place
towards the outer right edge of the bezel (3) and slide the bezel blank back and to the right to remove it
(4).

NOTE: After removing the slim optical drive bezel blank and installing a slim optical drive, you can install an
optional bezel trim piece (available from HP) that surrounds the front of the slim optical drive.

Bezel blanks
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Memory
Description
8-GB, PC3-12800
4-GB, PC3-12800
2-GB, PC3-12800

The computer comes with double data rate 3 synchronous dynamic random access memory (DDR3-SDRAM)
dual inline memory modules (DIMMs).

DIMMs
The memory sockets on the system board can be populated with up to two industry-standard DIMMs. These
memory sockets are populated with at least one preinstalled DIMM. To achieve the maximum memory
support, you can populate the system board with up to 16-GB of memory configured in a high-performing
dual channel mode.

DDR3-SDRAM DIMMs
For proper system operation, the DDR3-SDRAM DIMMs must be:
●

industry-standard 240-pin

●

unbuffered non-ECC PC3-12800 DDR3-1600 MHz-compliant

●

1.35 volt or 1.5 volt DDR3/DDR3L-SDRAM DIMMs

The DDR3-SDRAM DIMMs must also:
●

support CAS latency 11 DDR3 1600 MHz (11-11-11 timing)

●

contain the mandatory JEDEC SPD information

In addition, the computer supports:
●

512-Mbit, 1-Gbit, and 2-Gbit non-ECC memory technologies

●

single-sided and double-sided DIMMs

●

DIMMs constructed with x8 and x16 DDR devices; DIMMs constructed with x4 SDRAM are not supported

NOTE: The system will not operate properly if you install unsupported DIMMs.
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Populating DIMM sockets
There are two DIMM sockets on the system board, with one socket per channel. The sockets are labeled
DIMM1 and DIMM3. Socket DIMM1 operates in memory channel B. Socket DIMM3 operates in memory channel
A.
The system will automatically operate in single channel mode, dual channel mode, or flex mode, depending
on how the DIMMs are installed.
NOTE: Single channel and unbalanced dual channel memory configurations will result in inferior graphics
performance.
●

The system will operate in single channel mode if the DIMM sockets are populated in one channel only.

●

The system will operate in a higher-performing dual channel mode if the memory capacity of the DIMM
in Channel A is equal to the memory capacity of the DIMM in Channel B.

●

The system will operate in flex mode if the memory capacity of the DIMM in Channel A is not equal to the
memory capacity of the DIMM in Channel B. In flex mode, the channel populated with the least amount
of memory describes the total amount of memory assigned to dual channel and the remainder is
assigned to single channel. If one channel will have more memory than the other, the larger amount
should be assigned to Channel A.

●

In any mode, the maximum operational speed is determined by the slowest DIMM in the system.

Installing DIMMs
CAUTION: You must disconnect the power cord and wait approximately 30 seconds for the power to drain
before adding or removing memory modules. Regardless of the power-on state, voltage is always supplied to
the memory modules as long as the computer is plugged into an active AC outlet. Adding or removing
memory modules while voltage is present may cause irreparable damage to the memory modules or system
board.
The memory module sockets have gold-plated metal contacts. When upgrading the memory, it is important
to use memory modules with gold-plated metal contacts to prevent corrosion and/or oxidation resulting
from having incompatible metals in contact with each other.
Static electricity can damage the electronic components of the computer or optional cards. Before beginning
these procedures, ensure that you are discharged of static electricity by briefly touching a grounded metal
object.
When handling a memory module, be careful not to touch any of the contacts. Doing so may damage the
module.
1.

Prepare the computer for disassembly (Preparation for disassembly on page 19).

2.

Remove the access panel (Access panel on page 20).

3.

Rotate up the internal drive bay housing to access the memory module sockets on the system board.

Memory
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4.

Open both latches of the memory module socket (1), and insert the memory module into the socket (2).

NOTE: A memory module can be installed in only one way. Match the notch on the module with the tab
on the memory socket.
For maximum performance, populate the sockets so that the memory capacity is spread as equally as
possible between Channel A and Channel B.
5.

Push the module down into the socket, ensuring that the module is fully inserted and properly seated.
Make sure the latches are in the closed position (3).

6.

Repeat steps 4 and 5 to install any additional modules.

The computer should automatically recognize the additional memory the next time you turn on the
computer.
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Expansion card
Description
Nvidia NVS310 PCIe x16 graphics card, 512 MB
Nvidia NVS315 PCIe x16 graphics card, 1 GB
AMD Radeon HD8490 DP PCIe x16 graphics card, 1 GB
AMD Radeon HD8450 PCIe x16 graphics card, 1 GB
AMD Radeon HD8350 DH PCIe x16 graphics card, 1 GB DDR3
Intel PRO/1000 single port GbE NIC, includes bracket
Intel 802.11 a/b/g/n + Bluetooth 4.0 Wireless NIC
Intel Dual Band Wireless-N 7260 802.11 a/b/g/n (2x2) Wireless NIC

The computer has three PCI Express x1 expansion slots and one PCI Express x16 expansion slot.
NOTE: The PCI Express slots support only low profile cards.
You can install a PCI Express x1, x4, x8, or x16 expansion card in the PCI Express x16 slot.
For dual graphics card configurations, the first (primary) card must be installed in the PCI Express x16 slot.
To remove, replace, or add an expansion card:
1.

Prepare the computer for disassembly (Preparation for disassembly on page 19).

2.

Remove the access panel (Access panel on page 20).

3.

Locate the correct vacant expansion socket on the system board and the corresponding expansion slot
on the back of the computer chassis.

4.

Release the slot cover retention latch that secures the slot covers by lifting the green tab on the latch
and rotating the latch to the open position.

5.

Before installing an expansion card, remove the expansion slot cover or the existing expansion card.

Expansion card
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NOTE: Before removing an installed expansion card, disconnect any cables that may be attached to
the expansion card.
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a.

If you are installing an expansion card in a vacant socket, remove the appropriate expansion slot
cover on the back of the chassis. Pull the slot cover straight up then away from the inside of the
chassis.

b.

If you are removing a PCI Express x1 card, hold the card at each end, and carefully rock it back and
forth until the connectors pull free from the socket. Pull the expansion card straight up from the
socket (1) then away from the inside of the chassis to release it from the chassis frame (2). Be sure
not to scrape the card against the other components.
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c.

If you are removing a PCI Express x16 card, pull the retention arm on the back of the expansion
socket away from the card and carefully rock the card back and forth until the connectors pull free
from the socket. Pull the expansion card straight up from the socket then away from the inside of
the chassis to release it from the chassis frame. Be sure not to scrape the card against the other
components.

6.

Store the removed card in anti-static packaging.

7.

If you are not installing a new expansion card, install an expansion slot cover to close the open slot.
CAUTION: After removing an expansion card, you must replace it with a new card or expansion slot
cover for proper cooling of internal components during operation.

Expansion card
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8.

To install a new expansion card, hold the card just above the expansion socket on the system board
then move the card toward the rear of the chassis (1) so that the bracket on the card is aligned with the
open slot on the rear of the chassis. Press the card straight down into the expansion socket on the
system board (2).

NOTE: When installing an expansion card, press firmly on the card so that the whole connector seats
properly in the expansion card slot.
9.

Rotate the slot cover retention latch back in place to secure the expansion card.

10. Connect external cables to the installed card, if needed. Connect internal cables to the system board, if
needed.
11. Reconfigure the computer, if necessary.

System board connections
Refer to the following illustration and table to identify the system board connectors for your model.
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No.

System Board Connector

System Board Label

Color

Component

1

PCI Express x1

X1PCIEXP3

black

Expansion Card

2

PCI Express x1

X1PCIEXP2

black

Expansion Card

3

PCI Express x1

X1PCIEXP1

black

Expansion Card

4

PCI Express x16

X16PCIEXP

black

Expansion Card

5

Parallel Port

PAR

black

Optional Parallel Port

6

Serial Port

COMB

black

Optional Second Serial Port

7

Battery

BAT

black

Memory Module

8

DIMM3 (Channel A)

DIMM3

black

Memory Module

9

DIMM1 (Channel B)

DIMM1

black

Memory Module

10

SATA 3.0

SATA0

dark blue

Primary Hard Drive

11

SATA 3.0

SATA1

light blue

Secondary Hard Drive

12

SATA 2.0

SATA5

white

Optical Drive

13

USB 2.0

MEDIA

black

USB 2.0 Device, such as a Media Card
Reader

System board connections
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Drives
Description
Hard drive
2 TB, 7200 rpm, 3.5 inch
1 TB, 10000 rpm
1 TB, 7200 rpm, 3.5 inch
1 TB hard drive, hybrid SSD
500 GB, 10000 rpm
500 GB, 7200 rpm, 2.5 inch
500 GB, 7200 rpm, 2.5 inch, self-encrypting (SED)
500 GB, 5400 rpm, 2.5 inch, FIPS
500 GB hard drive, hybrid SSD
256-GB Solid-state Drive (SSD), self-encrypting (SED)
256-GB Solid-state Drive (SSD)
180-GB Solid-state Drive (SSD), MLC
128-GB Solid-state Drive (SSD)
128-GB Solid-state Drive (SSD), self-encrypting (SED)
120-GB Solid-state Drive (SSD), MLC
32-GB Solid-state Drive (SSD), 2.5 inch, MLC
Optical drive
Blu-ray BD-RW SuperMulti XL Drive
DVD±RW drive
DVD-ROM drive

When installing drives, follow these guidelines:
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●

The primary Serial ATA (SATA) hard drive must be connected to the dark blue primary SATA connector
on the system board labeled SATA0.

●

Connect a secondary hard drive to the light blue SATA connector on the system board labeled SATA1.

●

Connect an optical drive to the white SATA connector on the system board labeled SATA5.

●

Connect a media card reader USB 3.0 cable with a USB 3.0 to USB 2.0 adapter to the USB 2.0 connector
on the system board labeled MEDIA.

●

The power cable for the drives has two branches coming off the system board connector. The first
branch is a dual-headed cable with the first connector (four-wire) routed to the 3.5-inch optional drive
bay and the second connector (two-wire) routed to the slim optical drive bay. The second branch is a
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dual-headed cable with the first connector routed to the 3.5-inch hard drive bay and the second
connector routed to the 2.5-inch hard drive bay.
●

You must install guide screws to ensure the drive will line up correctly in the drive cage and lock in
place. HP has provided four extra 6-32 standard guide screws installed on the top of the drive bay. The
6-32 standard guide screws are required for a media card reader or a secondary hard drive installed in
the 3.5-inch optional drive bay. M3 isolation mounting guide screws for 2.5-inch hard drives are not
provided. If you are replacing a drive, remove the guide screws from the old drive and install them in the
new drive.

There are a total of five extra silver 6-32 standard screws. One is used for bezel security (1) (see Front bezel
security on page 22 for more information). The other four are used as guide screws for a media card reader or
a secondary hard drive in the 3.5-inch optional drive bay (2).
CAUTION: To prevent loss of work and damage to the computer or drive:
If you are inserting or removing a drive, shut down the operating system properly, turn off the computer, and
unplug the power cord. Do not remove a drive while the computer is on or in standby mode.
Before handling a drive, ensure that you are discharged of static electricity. While handling a drive, avoid
touching the connector.
Handle a drive carefully; do not drop it.
Do not use excessive force when inserting a drive.
Avoid exposing a hard drive to liquids, temperature extremes, or products that have magnetic fields such as
monitors or speakers.
If a drive must be mailed, place the drive in a bubble-pack mailer or other protective packaging and label the
package “Fragile: Handle With Care.”

Drives
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Drive positions

1

Slim optical drive bay

2

3.5-inch internal hard drive bay

3

3.5-inch drive bay for optional drives (media card reader shown)

4

2.5-inch internal hard drive bay

NOTE: The drive configuration on your computer may be different than the drive
configuration shown above.

To verify the type and size of the storage devices installed in the computer, run Computer Setup.

Removing a 3.5-inch device
CAUTION: All removable media should be taken out of a drive before removing the drive from the
computer.
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1.

Prepare the computer for disassembly (Preparation for disassembly on page 19).

2.

Remove the access panel (Access panel on page 20).

3.

Remove the front bezel (Front bezel on page 21).

4.

Rotate the drive cage to its upright position.
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5.

Disconnect the drive cables from the rear of the drive, or, if you are removing a media card reader,
disconnect the USB cable from the system board as indicated in the following illustration.

6.

Press inward on the release lever at the rear of the device (1) and slide the device out of the rear of the
drive bay (2).

Installing a 3.5-inch device
1.

Prepare the computer for disassembly (Preparation for disassembly on page 19).

2.

Remove the access panel (Access panel on page 20).

3.

Remove the front bezel (Front bezel on page 21). If you are installing a drive in a bay covered by a bezel
blank, remove the bezel blank. See Bezel blanks on page 23 for more information.

Drives
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4.

Install 6-32 guide screws in the holes on each side of the device.
NOTE: HP has supplied four extra 6-32 guide screws on top of the drive cage. Refer to Drives
on page 32 for an illustration of the extra guide screws location.
When replacing a device, transfer the four 6-32 guide screws from the old device to the new one.

5.
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Rotate the drive cage to its upright position.
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6.

Slide the device into the drive bay, making sure to align the guide screws with the guide slots, until the
device snaps into place.

7.

If installing a USB 3.0 media card reader, you must use the USB 3.0 to USB 2.0 adapter and connect the
adapter cable from the media card reader to the USB 2.0 connector on the system board labeled MEDIA.

NOTE: Refer to System board connections on page 30 for an illustration of the system board drive
connectors.
8.

Rotate the drive cage back down to its normal position.
CAUTION:

Be careful not to pinch any cables or wires when rotating the drive cage down.

Drives
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Removing a slim optical drive
CAUTION: All removable media should be taken out of a drive before removing the drive from the
computer.
1.

Prepare the computer for disassembly (Preparation for disassembly on page 19).

2.

Remove the access panel (Access panel on page 20).

3.

Disconnect the power and data cables (1) from the rear of the optical drive, push the green release latch
on the right rear side of the drive toward the center of the drive (2), then slide the drive forward and out
of the bay through the front bezel (3).
CAUTION: When removing the cables, pull the tab or connector instead of the cable itself to avoid
damaging the cable.
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Installing a slim optical drive
1.

Prepare the computer for disassembly (Preparation for disassembly on page 19).

2.

If the computer is on a stand, remove the computer from the stand.

3.

Remove the access panel (Access panel on page 20).

4.

Remove the front bezel (Front bezel on page 21) if you are installing a drive in a bay covered by a bezel
blank, then remove the bezel blank. See Bezel blanks on page 23 for more information.

5.

Before the new optical drive can be used, the release latch must be attached.
a.

Peel the backing off the adhesive on the release latch.

b.

Without allowing the release latch to touch the optical drive, carefully align the holes on the
release latch with the pins on the side of the optical drive. Make sure the release latch is oriented
properly.

c.

Insert the pin at the front of the optical drive into the hole at the end of the release latch, and
press firmly.

d.

Insert the second pin, and press the entire release latch firmly to fasten the latch securely to the
optical drive.

Drives
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6.

Slide the optical drive through the front bezel all the way into the bay so that it locks in place (1), then
connect the power and data cables to the rear of the drive (2).

7.

Connect the opposite end of the data cable to the white SATA connector on the system board labeled
SATA5.
NOTE: Refer to System board connections on page 30 for an illustration of the system board drive
connectors.

8.

Replace the front bezel if it was removed.
NOTE: An optional bezel trim piece that surrounds the front of the optical drive is available from HP.
Install the bezel trim piece in the front bezel before installing the front bezel.

Removing and replacing a 3.5-inch hard drive
NOTE: Before you remove the old hard drive, be sure to back up the data from the old hard drive so that
you can transfer the data to the new hard drive.
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1.

Prepare the computer for disassembly (Preparation for disassembly on page 19).

2.

If the computer is on a stand, remove the computer from the stand.

3.

Remove the access panel (Access panel on page 20).

4.

Disconnect the power cable and data cable from the back of the hard drive.
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5.

Pull the release lever next to the rear of the hard drive outward (1). While pulling the release lever out,
slide the drive back until it stops, then lift the drive up and out of the bay (2).

6.

To install a hard drive, you must transfer the silver and blue isolation mounting guide screws from the
old hard drive to the new hard drive.

Drives
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7.

Align the guide screws with the slots on the chassis drive cage, press the hard drive down into the bay,
then slide it forward until it stops and locks in place.

8.

Connect the power cable and data cable to the back of the hard drive.
NOTE: The data cable for the primary hard drive must be connected to the dark blue connector labeled
SATA0 on the system board to avoid any hard drive performance problems.

9.

Replace the access panel.

10. If the computer was on a stand, replace the stand.
11. Reconnect the power cord and turn on the computer.
12. Lock any security devices that were disengaged when the access panel was removed.
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Removing a 2.5-inch hard drive
1.

Prepare the computer for disassembly (Preparation for disassembly on page 19).

2.

Remove the access panel (Access panel on page 20).

3.

Rotate the drive cage to its upright position.

4.

Disconnect the power cable and data cable from the back of the hard drive.

5.

Pull outward on the release lever at the rear of the drive (1) then slide the drive back until it stops and
pull it down and out of the drive bay (2).

Installing a 2.5-inch hard drive
1.

Prepare the computer for disassembly (Preparation for disassembly on page 19).

2.

If the computer is on a stand, remove the computer from the stand.

3.

Remove the access panel (Access panel on page 20).

Drives
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4.

Install four black and blue M3 isolation mounting guide screws (two on each side of the drive).
NOTE:

M3 metric isolation mounting guide screws can be purchased from HP.

When replacing a drive, transfer the four M3 isolation mounting guide screws from the old drive to the
new one.

5.

Rotate the drive cage to its upright position.

6.

Align the guide screws on the drive with the J-slots on the sides of the drive bay. Press the drive up into
the drive bay then slide it forward until it locks in place.

7.

Connect the power cable and data cable to the back of the hard drive.
NOTE: If the 2.5-inch hard drive is the primary drive, connect the data cable to the dark blue SATA
connector labeled SATA0 on the system board. If it is a secondary drive, connect the data cable to one of
the light blue SATA connectors on the system board.

8.

Rotate the drive cage back down to its normal position.
CAUTION:
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Be careful not to pinch any cables or wires when rotating the drive cage down.
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Power supply
Description
Power supply, 240W, 85% efficient
Power supply, 240W, standard

WARNING! To reduce potential safety issues, only the power supply provided with the computer, a
replacement power supply provided by HP, or a power supply purchased as an accessory from HP should be
used with the computer.
The power supply is located at the rear of the chassis. It is held in place by three Torx screws outside of the
chassis and a release lever inside of the chassis.
WARNING! Voltage is always present on the system board when the computer is plugged into an active AC
outlet. To avoid possible personal injury and damage to the equipment the power cord should be
disconnected from the computer and/or the AC outlet before opening the computer.
1.

Prepare the computer for disassembly (Preparation for disassembly on page 19).

2.

Remove the access panel (Access panel on page 20).

3.

Rotate the drive cage to the upright position.

4.

Disconnect all power cables from the following system board connectors:

5.

●

PWRCPU

●

PWRCMD

●

PWR

Release the power supply cables from the cable retaining clip under the drive cage.

Power supply
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6.

From the outside, rear of the computer, remove the three Torx screws that secure the power supply to
the rear of the chassis.

7.

From the inside of the chassis, press the release button at the front of the power supply (1).

8.

Slide the power supply forward (2), and then lift it out of the chassis (3).

To install the power supply, reverse the removal procedure.
CAUTION: When installing the power supply cables, make sure they are properly positioned in the clip
under the drive cage.
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Fan duct
The fan duct sits between the front fan and the heat sink.
1.

Prepare the computer for disassembly (Preparation for disassembly on page 19).

2.

Remove the access panel (Access panel on page 20).

3.

Rotate the fan duct upward.

4.

Pull the duct away from the chassis to disengage the clips on the duct from the chassis.

To install the fan duct, insert the clips on the edge of the fan onto the metal posts on the chassis.

Fan duct
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Front I/O assembly
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1.

Prepare the computer for disassembly (Preparation for disassembly on page 19).

2.

Remove the access panel (Access panel on page 20).

3.

Remove the front bezel (Front bezel on page 21).

4.

Rotate the drive cage to its upright position.

5.

Cut the plastic tie that secures the longer cable to the power supply.

6.

Disconnect the cables from the system board as follows:
●

Yellow connector labeled FRONT USB

●

Blue connector labeled FRONT USB 3.0

●

Blue connector labeled FRONT AUD
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7.

Remove the cables from the cable clips under the drive cage.

8.

Remove the Torx T15 screw (1) that secures the assembly to the front of the chassis.

Front I/O assembly
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9.

Press the tab on the right side of the assembly (2) to disengage it from the chassis.

10. Push the assembly into the chassis, and then remove it from the chassis.

To install the assembly, insert the assembly from the inside of the chassis, and then pull the tab on the left
side of the assembly out the front of the chassis. Push the right side until it clicks into place.
NOTE: Be sure to correctly route the cables beneath the drive cage when reinstalling the assembly. Proper
cable routing prevents damage to the cables and allows the drive cage to close properly.
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Power switch assembly
1.

Prepare the computer for disassembly (Preparation for disassembly on page 19).

2.

Remove the access panel (Access panel on page 20).

3.

Remove the front bezel (Front bezel on page 21).

4.

Rotate the drive cage to its upright position.

5.

Disconnect the cable from the system board connector labeled PB/LED.

6.

Remove the cable from the cable clips under the drive cage.

Power switch assembly
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7.

From the inside of the chassis, press down on the tab on the top of the power switch to disengage the
power switch from the chassis.

8.

Pull the power switch out the front of the chassis, while routing the cable through the hole in the
chassis.

To install the power switch assembly, first insert the cable through the hole from the front of the chassis.
After inserting the cable, place the bottom of the assembly into the slot, and then rotate the top up until it
snaps into place.
NOTE: Be sure to correctly route the cables beneath the drive cage when reinstalling the assembly. Proper
cable routing prevents damage to the cables and allows the drive cage to close properly.
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Speaker
The speaker is attached to the front of the chassis under the rotating drive cage.
1.

Prepare the computer for disassembly (Preparation for disassembly on page 19).

2.

Remove the access panel (Access panel on page 20).

3.

Remove the front bezel (Front bezel on page 21).

4.

Rotate the drive cage to its upright position.

5.

Lift the metal clip (1) that secures the speaker cable, and then disconnect the speaker wire from the
white system board connector labeled SPKR (2).

6.

From the outside, front of the chassis, remove the two Torx screws that secure the speaker to the
chassis.

Speaker
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7.

Lift the speaker from the inside of the chassis to remove it.

To install the speaker, reverse the removal procedures.
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Fan sink
The fan sink is secured atop the processor with four captive Torx screws. The fan sink includes a heat sink
and a fan.
1.

Prepare the computer for disassembly (Preparation for disassembly on page 19).

2.

Remove the access panel (Access panel on page 20).

3.

Remove the fan duct (Fan duct on page 47).

4.

Loosen the four captive Torx T15 screws that secure the fan sink to the system board tray.
CAUTION: Remove fan sink retaining screws in diagonally opposite pairs (as in an X) to even the
downward forces on the processor. This is especially important as the pins on the socket are very fragile
and any damage to them may require replacing the system board.

Fan sink
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5.

Disconnect the fan cable from the system board connector labeled CPUFAN (1), and then lift the heat
sink from atop the processor (2).

When reinstalling the fan sink, make sure that its bottom has been cleaned with an alcohol wipe and fresh
thermal grease has been applied to the top of the processor.
CAUTION: Fan sink retaining screws should be tightened in diagonally opposite pairs (as in an X) to evenly
seat the fan sink on the processor to avoid damage that could require replacing the system board.
Make sure to replace the fan duct. Failure to install the fan duct may cause the computer to overheat.
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Processor
Description
Intel Core i7 4790 (3.6-GHz, 8-MB L3 cache), 84W
Intel Core i7 4790s (3.2-GHz, 8-MB L3 cache), 65W
Intel Core i7 4771 (3.5-GHz, 8-MB L3 cache), 84W
Intel Core i7 4770 (3.4-GHz, 8-MB L3 cache), 84W
Intel Core i7 4770s (3.1-GHz, 8-MB L3 cache), 65W
Intel Core i5 4690 (3.5-GHz, 6-MB L3 cache), 84W
Intel Core i5 4690s (3.2-GHz, 6-MB L3 cache), 65W
Intel Core i5 4670 (3.4-GHz, 6-MB L3 cache), 84W
Intel Core i5 4670s (3.1-GHz, 6-MB L3 cache), 65W
Intel Core i5 4590 (3.3-GHz, 6-MB L3 cache), 84W
Intel Core i5 4590s (3.0-GHz, 6-MB L3 cache), 65W
Intel Core i5 4570 (3.2-GHz, 6-MB L3 cache), 84W
Intel Core i5 4570s (2.9-GHz, 6-MB L3 cache), 65W
Intel Core i5 4430 (3.0-GHz, 6-MB L3 cache), 84W
Intel Core i5 4430s (2.7-GHz, 6-MB L3 cache), 65W
Intel Core i3 4370 (3.8-GHz, 4-MB L3 cache), 54W
Intel Core i3 4360 (3.7-GHz, 4-MB L3 cache), 54W
Intel Core i3 4350 (3.6-GHz, 4-MB L3 cache), 54W
Intel Core i3 4340 (3.6-GHz, 4-MB L3 cache), 54W
Intel Core i3 4330 (3.5-GHz, 4-MB L3 cache), 54W
Intel Core i3 4160 (3.6-GHz, 4-MB L3 cache), 54W
Intel Core i3 4150 (3.5-GHz, 4-MB L3 cache), 54W
Intel Core i3 4130 (3.4-GHz, 4-MB L3 cache), 54W
Intel Pentium G3460 (3.5-GHz, 3-MB L3 cache), 53W
Intel Pentium G3450 (3.4-GHz, 3-MB L3 cache), 54W
Intel Pentium G3440 (3.3-GHz, 3-MB L3 cache), 54W
Intel Pentium G3430 (3.3-GHz, 3-MB L3 cache), 54W
Intel Pentium G3420 (3.2-GHz, 3-MB L3 cache), 54W
Intel Pentium G3250 (3.2-GHz, 3-MB L3 cache), 53W
Intel Pentium G3240 (3.1-GHz, 3-MB L3 cache), 54W
Intel Pentium G3220 (3.0-GHz, 3-MB L3 cache), 54W

Processor
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Description
Intel Celeron G1850 (2.9-GHz, 2-MB L3 cache)
Intel Celeron G1840 (2.8-GHz, 2-MB L3 cache)

1.

Prepare the computer for disassembly (Preparation for disassembly on page 19).

2.

Remove the access panel (Access panel on page 20).

3.

Remove the fan duct (Fan duct on page 47).

4.

Remove the fan sink (Fan sink on page 55).

5.

Rotate the locking lever to its full open position (1).

6.

Raise and rotate the microprocessor retainer to its fully open position (2).

7.

Carefully lift the processor from the socket (3).
CAUTION: Do NOT handle the pins in the processor socket. These pins are very fragile and handling
them could cause irreparable damage. Once pins are damaged it may be necessary to replace the
system board.
The heat sink must be installed within 24 hours of installing the processor to prevent damage to the
processor’s solder connections.

NOTE: After installing a new processor onto the system board, always update the system ROM to ensure
that the latest version of the BIOS is being used on the computer. The latest system BIOS can be found on the
Web at: http://www8.hp.com/us/en/support-drivers.html.
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System board
Description
System board for use in models without Windows 8 (includes thermal material)
System board for use in models with Windows 8 Standard (includes thermal material)
System board for use in models with Windows 8 Professional (includes thermal material)
System board for use only in models in the People’s Republic of China with NetClone (includes thermal material)

1.

Prepare the computer for disassembly (Preparation for disassembly on page 19).

2.

Remove the access panel (Access panel on page 20).

3.

When replacing the system board, make sure the following components are removed from the defective
system board and installed on the replacement system board:
●

Memory modules (Memory on page 24)

●

Expansion cards (Expansion card on page 27)

●

Fan sink (Fan sink on page 55)

●

Processor (Processor on page 57)

4.

Remove the fan duct from the chassis (Fan duct on page 47).

5.

Rotate the drive cage to its upright position.

6.

Disconnect all data and power cables from the system board.

7.

Remove the eight Torx screws that secure the system board to the chassis.

8.

Slide the system board toward the front of the chassis to disengage the connectors.

9.

Lift the system board up and out of the chassis.

System board

59

To install the system board, reverse the removal procedure.
NOTE: When replacing the system board, you must also change the chassis serial number in the BIOS.
CAUTION: When reconnecting the cables it is important that they be positioned correctly.

Changing from desktop to tower configuration
The Small Form Factor computer can be used in a tower orientation with an optional tower stand that can be
purchased from HP.
1.

Prepare the computer for disassembly (Preparation for disassembly on page 19).

2.

Orient the computer so that its right side is facing down and place the computer in the optional stand.

NOTE:
stand.
3.

To stabilize the computer in a tower orientation, HP recommends the use of the optional tower

Reconnect the power cord and any external devices, then turn on the computer.
NOTE: Ensure at least 10.2 centimeters (4 inches) of space on all sides of the computer remains clear
and free of obstructions.
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5

Computer Setup (F10) Utility

Computer Setup (F10) Utilities
Use Computer Setup (F10) Utility to do the following:
●

Change factory default settings.

●

Set the system date and time.

●

Set, view, change, or verify the system configuration, including settings for processor, graphics,
memory, audio, storage, communications, and input devices.

●

Modify the boot order of bootable devices such as hard drives, optical drives, or USB flash media
devices.

●

Enable Quick Boot, which is faster than Full Boot but does not run all of the diagnostic tests run during a
Full Boot. You can set the system to:
■

always Quick Boot (default);

■

periodically Full Boot (from every 1 to 30 days); or

■

always Full Boot.

●

Select Post Messages Enabled or Disabled to change the display status of Power-On Self-Test (POST)
messages. Post Messages Disabled suppresses most POST messages, such as memory count, product
name, and other non-error text messages. If a POST error occurs, the error is displayed regardless of
the mode selected. To manually switch to Post Messages Enabled during POST, press any key (except
F1 through F12).

●

Establish an Ownership Tag, the text of which is displayed each time the system is turned on or
restarted.

●

Enter the Asset Tag or property identification number assigned by the company to this computer.

●

Enable the power-on password prompt during system restarts (warm boots) as well as during poweron.

●

Establish a setup password that controls access to the Computer Setup (F10) Utility and the settings
described in this section.

●

Secure integrated I/O functionality, including the serial, USB, or parallel ports, audio, or embedded NIC,
so that they cannot be used until they are unsecured.

●

Enable or disable removable media boot ability.

●

Solve system configuration errors detected but not automatically fixed during the Power-On Self-Test
(POST).

●

Replicate the system setup by saving system configuration information on a USB device and restoring it
on one or more computers.

●

Execute self-tests on a specified ATA hard drive (when supported by drive).

●

Enable or disable DriveLock security (when supported by drive).

Computer Setup (F10) Utilities
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Using Computer Setup (F10) Utilities
Computer Setup can be accessed only by turning the computer on or restarting the system. To access the
Computer Setup Utilities menu, complete the following steps:
1.

Turn on or restart the computer.

2.

Repeatedly press F10 when the monitor light turns green to access the utility.
You can also press Esc to a menu that allows you to access different options available at startup,
including the Computer Setup utility.
NOTE: If you do not press F10 at the appropriate time, you must restart the computer and again
repeatedly press F10 when the monitor light turns green to access the utility.

3.

A choice of five headings appears in the Computer Setup Utilities menu: File, Storage, Security, Power,
and Advanced.

4.

Use the arrow (left and right) keys to select the appropriate heading. Use the arrow (up and down) keys
to select the option you want, then press Enter. To return to the Computer Setup Utilities menu, press
Esc.

5.

To apply and save changes, select File > Save Changes and Exit.
●

If you have made changes that you do not want applied, select Ignore Changes and Exit.

●

To reset to factory settings or previously saved default settings (some models), select Apply
Defaults and Exit. This option will restore the original factory system defaults.

NOTE:

Not all settings shown in the following sections are available for all models

CAUTION: Do NOT turn the computer power OFF while the BIOS is saving the Computer Setup (F10) changes
because the CMOS could become corrupted. It is safe to turn off the computer only after exiting the F10
Setup screen.
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Computer Setup—File
NOTE: Support for specific Computer Setup options may vary depending on the hardware configuration.
Table 5-1 Computer Setup—File
Option

Description

System Information

Lists:
●

Product name

●

Manufacturer

●

SKU number

●

Processor type/speed/stepping

●

Cache size (L1/L2/L3) (dual core processors have this listed twice)

●

Installed memory size/speed, number of channels (single or dual) (if applicable)

●

Integrated MAC address for embedded, enabled NIC (if applicable)

●

Chassis serial number

●

Asset tracking number

●

System Board ID and CT Number

●

System BIOS Version and Date

About

Displays copyright notice.

Set Time and Date

Allows you to set system time and date.

Flash System ROM

Allows you to update the system ROM with a BIOS image file located on removable media.

Replicated Setup

Save to Removable Media
Saves system configuration to a formatted USB flash media device.
Restore from Removable Media
Restores system configuration from a USB flash media device.

Default Setup

Save Current Settings as Default
Saves the current system configuration settings as the default.
Restore Factory Settings as Default
Restores the factory system configuration settings as the default.

Apply Defaults and Exit

Applies the currently selected default settings and clears any established passwords.

Ignore Changes and Exit

Exits Computer Setup without applying or saving any changes.

Save Changes and Exit

Saves changes to system configuration or default settings and exits Computer Setup.

Computer Setup (F10) Utilities
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Computer Setup—Storage
NOTE: Support for specific Computer Setup options may vary depending on the hardware configuration.
Table 5-2 Computer Setup—Storage
Option

Description

Device Configuration

Lists all installed BIOS-controlled storage devices.
When a device is selected, detailed information and options are displayed. The following options may be
presented:
●

Hard Disk: Size, model, firmware version, serial number, connector color, SMART category.

●

CD-ROM: Model, firmware version, serial number, connector color (not included for USB CD-ROM).

●

SMART (ATA disks only)

●

Diskette: Model and firmware version.

NOTE:
Storage Options

Displays for USB diskette drives.

SATA Emulation
Allows you to choose how the SATA controller and devices are accessed by the operating system. There
are three supported options: IDE, RAID, and AHCI (default).
CAUTION: SATA emulation changes may prevent access to existing hard drive data and degrade or
corrupt established volumes.
IDE - This is the most backwards-compatible setting of the three options. Operating systems usually do
not require additional driver support in IDE mode.
RAID - Allows DOS and boot access to RAID volumes. Use this mode with the RAID device driver loaded in
the operating system to take advantage of RAID features.
AHCI (default option) - Allows operating systems with AHCI device drivers loaded to take advantage of
more advanced features of the SATA controller.
NOTE: The RAID/AHCI device driver must be installed prior to attempting to boot from a RAID/AHCI
volume. If you attempt to boot from a RAID/AHCI volume without the required device driver installed, the
system will crash (blue screen). RAID volumes may become corrupted if they are booted to after disabling
RAID.
Removable Media Boot
Enables/disables ability to boot the system from removable media. Default is enabled.

Boot Order

Allows you to:
●

UEFI Boot Sources: Specify the order in which EFI boot sources (such as a internal hard drive, USB
hard drive, USB optical drive, or internal optical drive) are checked for a bootable operating system
image. Each device on the list may be individually excluded from or included for consideration as a
bootable operating system source.
EFI boot sources always have precedence over legacy boot sources.

●

Legacy Boot Sources: Specify the order in which legacy boot sources (such as a network interface
card, internal hard drive, USB optical drive, or internal optical drive) are checked for a bootable
operating system image. Each device on the list may be individually excluded from or included for
consideration as a bootable operating system source.
Specify the order of attached hard drives. The first hard drive in the order will have priority in the
boot sequence and will be recognized as drive C (if any devices are attached).

NOTE: To drag a device to a preferred place, press Enter. To remove the device from consideration as a
bootable device, press F5.
You can use F5 to disable individual boot items, as well as disable EFI boot and/or legacy boot.
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Table 5-2 Computer Setup—Storage (continued)
NOTE: MS-DOS drive lettering assignments may not apply after a non-MS-DOS operating system has
started.
Shortcut to Temporarily Override Boot Order
To boot one time from a device other than the default device specified in Boot Order, restart the
computer and press Esc (to access the boot menu) and then F9 (Boot Order), or only F9 (skipping the boot
menu) when the monitor light turns green. After POST is completed, a list of bootable devices is
displayed. Use the arrow keys to select the preferred bootable device and press Enter. The computer then
boots from the selected non-default device for this one time.

Computer Setup—Security
NOTE: Support for specific Computer Setup options may vary depending on the hardware configuration.
Table 5-3 Computer Setup—Security
Option

Description

Setup Password

Allows you to set and enable a setup (administrator) password.
NOTE: If the setup password is set, it is required to change Computer Setup options, flash the ROM, and
make changes to certain plug and play settings under Windows.

Power-On Password

Allows you to set and enable a power-on password. The power-on password prompt appears after a
power cycle or reboot. If the user does not enter the correct power-on password, the unit will not boot.

Password Options

Allows you to enable/disable:

(This selection appears
only if a power-on
password or setup
password is set.)

●

Lock Legacy Resources (determines whether or not Windows Device Manager is allowed to change
resource settings for serial and parallel ports).

●

Stringent security (enabling the stringent password disables the ability to reset the password by
moving the jumper on the system board). Default is disabled.
CAUTION: If you enable the stringent security feature and you forget the setup password or the
power-on password, the computer is inaccessible and can no longer be used.
If you lose or forget the password, the system board must be replaced. This scenario is not covered
under warranty.
To prevent the computer from becoming permanently unusable, record your configured setup
password or power-on password in a safe place away from your computer. Without these
passwords, the computer cannot be unlocked.

Smart Cover

●

Setup Browse Mode (appears if a setup password is set) (allows viewing, but not changing, the F10
Setup Options without entering setup password). Default is enabled.

●

Password prompt on F9 & F12 (requires setup password to use these boot functions). Default is
enabled.

●

Network Server Mode. Default is disabled.

Only displays if the computer is equipped with a smart cover.
Allows you to:
●

Lock/unlock the Cover Lock.

●

Set the Cover Removal Sensor to Disable/Notify User/Setup Password.

NOTE: Notify User alerts the user that the sensor has detected that the cover has been removed. Setup
Password requires that the setup password be entered to boot the computer if the sensor detects that
the cover has been removed.
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Table 5-3 Computer Setup—Security (continued)
Device Security

Allows you to set Device Available/Device Hidden (default is Device Available) for:
●

Embedded security device

●

System audio

●

USB controller (varies by model)

●

Network controller
NOTE:

USB Security

You must disable AMT before trying to hide the network controller.

●

Serial port

●

Parallel port

●

SATA ports (varies by model)

Allows you to set Enabled/Disabled (default is Enabled) for:
●

Front USB Ports

●

Rear USB Ports

●

Accessory USB Ports

Slot Security

Allows you to disable any PCI or PCI Express slot. Default is enabled.

Network Boot

Enables/disables the computer’s ability to boot from an operating system installed on a network server.
(Feature available on NIC models only; the network controller must be either a PCI expansion card or
embedded on the system board.) Default is enabled.

System IDs

Allows you to set:

Master Boot Record
Security

●

Asset tag (18-byte identifier), a property identification number assigned by the company to the
computer.

●

Ownership tag (80-byte identifier) displayed during POST.

●

Universal Unique Identifier (UUID) number. The UUID can only be updated if the current chassis
serial number is invalid. (These ID numbers are normally set in the factory and are used to uniquely
identify the system.)

●

Keyboard locale setting for System ID entry.

Enables/disables Master Boot Record (MBR) security.
The MBR contains information needed to successfully boot from a disk and to access the data stored on
the disk. Master Boot Record Security may prevent unintentional or malicious changes to the MBR, such
as those caused by some viruses or by the incorrect use of certain disk utilities. It also allows you to
recover the "last known good" MBR, should changes to the MBR be detected when the system is
restarted.
When MBR Security is enabled, the BIOS prevents any changes being made to the MBR of the current
bootable disk while in MS-DOS or Windows Safe Mode.
NOTE: Most operating systems control access to the MBR of the current bootable disk; the BIOS cannot
prevent changes that may occur while the operating system is running.
Restores the backup Master Boot Record to the current bootable disk. Default is disabled.
Only appears if all of the following conditions are true:
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●

MBR security is enabled

●

A backup copy of the MBR has been previously saved

●

The current bootable disk is the same disk from which the backup copy was saved
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Table 5-3 Computer Setup—Security (continued)
CAUTION: Restoring a previously saved MBR after a disk utility or operating system has modified the
MBR, may cause the data on the disk to become inaccessible. Only restore a previously saved MBR if you
are confident that the current bootable disk's MBR has been corrupted or infected with a virus.
System Security (these
options are hardware
dependent)

NOTE:

Available options are displayed depending on system configuration.

Data Execution Prevention (enable/disable) - Helps prevent operating system security breaches. Default
is enabled.
SVM CPU Virtualization (enable/disable). Controls the virtualization features of the processor. Changing
this setting requires turning the computer off and then back on. Default is disabled.
Virtualization Technology (VTx) (enable/disable) - Controls the virtualization features of the processor.
Changing this setting requires turning the computer off and then back on. Default is disabled.
Virtualization Technology Directed I/O (VTd) (enable/disable) - Controls virtualization DMA remapping
features of the chipset. Changing this setting requires turning the computer off and then back on. Default
is disabled.
Trusted Execution Technology (enable/disable) - Controls the underlying processor and chipset features
needed to support a virtual appliance. Changing this setting requires turning the computer off and then
back on. Default is disabled. To enable this feature you must enable the following features:
●

Embedded Security Device Support

●

Virtualization Technology

●

Virtualization Technology Directed I/O

Embedded Security Device (enable/disable) - Permits activation and deactivation of the Embedded
Security Device.
NOTE:
●

To configure the Embedded Security Device, a Setup password must be set.

Reset to Factory Settings (Do not reset/Reset) - Resetting to factory defaults will erase all security
keys and leave the device in a disabled state. Changing this setting requires that you restart the
computer. Default is Do not reset.
CAUTION: The embedded security device is a critical component of many security schemes.
Erasing the security keys will prevent access to data protected by the Embedded Security Device.
Choosing Reset to Factory Settings may result in significant data loss.

●

System Security
(continued)

Measure boot variables/devices to PCR1 - Typically, the computer measures the boot path and
saves collected metrics to PCR5 (a register in the Embedded Security Device). Bitlocker tracks
changes to any of these metrics, and forces the user to re-authenticate if it detects any changes.
Enabling this feature lets you set Bitlocker to ignore detected changes to boot path metrics, thereby
avoiding re-authentication issues associated with USB keys inserted in a port. Default is enabled.

OS management of Embedded Security Device (enable/disable) - This option allows the user to limit OS
control of the Embedded Security Device. Default is enabled. This option is automatically disabled if
Trusted Execution Technology is enabled.
●

Reset of Embedded Security Device through OS (enable/disable) - This option allows the user to
limit the operating system ability to request a Reset to Factory Settings of the Embedded Security
Device. Default is disabled.
NOTE:

To enable this option, a Setup password must be set.

●

No PPI provisioning (Windows 8 only) - This option lets you set Windows 8 to bypass the PPI
(Physical Presence Interface) requirement and directly enable and take ownership of the TPM on
first boot. You cannot change this setting after TPM is owned/initialized, unless the TPM is reset.
Default is disabled for non-Windows 8 systems, and enabled for Windows 8.

●

Allow PPI policy to be changed by OS. Enabling this option allows the operating system to execute
TPM operations without Physical Presence Interface. Default is disabled.
NOTE:

To enable this option, a Setup password must be set.
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Table 5-3 Computer Setup—Security (continued)
DriveLock Security

Allows you to assign or modify a master or user password for hard drives. When this feature is enabled,
the user is prompted to provide one of the DriveLock passwords during POST. If neither is successfully
entered, the hard drive will remain inaccessible until one of the passwords is successfully provided during
a subsequent cold-boot sequence.
NOTE: This selection will only appear when at least one drive that supports the DriveLock feature is
attached to the system.

Secure Boot
Configuration

●

Legacy Support—Enable/Disable. Allows you to turn off all legacy support on the computer,
including booting to DOS, running legacy graphics cards, booting to legacy devices, and so on. If set
to disable, legacy boot options in Storage > Boot Order are not displayed. Default is enabled.

●

Secure Boot—Enable/Disable. Allows you to make sure an operating system is legitimate before
booting to it, making Windows resistant to malicious modification from preboot to full OS booting,
preventing firmware attacks. UEFI and Windows Secure Boot only allow code signed by preapproved digital certificates to run during the firmware and OS boot process. Default is disabled,
except for Windows 8 systems which have this setting enabled. Secure Boot enabled also sets
Legacy Support to disabled.

●

Key Management—This option lets you manage the custom key settings.

●

◦

Clear Secure Boot Keys—Don't Clear/Clear. Allows you to delete any previously loaded custom
boot keys. Default is Don't Clear.

◦

Key Ownership—HP Keys/Custom Keys. Selecting Custom Mode allows you to modify the
contents of the secure boot signature databases and the platform key (PK) that verifies
kernels during system start up, allowing you to use alternative operating systems. Selecting
HP Keys causes the computer boot using the preloaded HP-specific boot keys. Default is HP
Keys.

Fast Boot—Enable/Disable. Fast boot disables the ability to interrupt boot, such as pressing f keys
to access items before the operating system loads. Default is disabled.
NOTE: If Windows 8 detects a serious error, it will interrupt the boot process automatically and
display advanced boot options.
From Windows 8, you can press Shift and select Restart to access the screen that lets you boot to a
device or troubleshoot your computer.

Computer Setup—Power
NOTE: Support for specific Computer Setup options may vary depending on the hardware configuration.
Table 5-4 Computer Setup—Power
Option

Description

OS Power Management

●

Idle Power Savings—Extended/Normal. Allows certain operating systems to decrease the
processors power consumption when the processor is idle. Default is extended.

●

Runtime Power Management— Enable/Disable. Allows certain operating systems to reduce
processor voltage and frequency when the current software load does not require the full
capabilities of the processor. Default is enabled.

●

Unique Sleep State Blink Rates—Enable/Disable. This feature is designed to provide a visual
indication of what sleep state the system is in. Each sleep state has a unique blink pattern. Default
is disabled.
NOTE: For Windows 8 systems with Fast Boot support, a normal shutdown goes to the S4 state,
not the S5 state.
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◦

S0 (On) = Solid white LED.

◦

S3 (Stand By)= 3 blinks at 1Hz (50% duty cycle) followed by a pause of 2 seconds (white LED)
— repeated cycles of 3 blinks and a pause.
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Table 5-4 Computer Setup—Power (continued)

Hardware Power
Management

◦

S4 (Hibernation)= 4 blinks at 1Hz (50% duty cycle) followed by a pause of 2 seconds (white
LED) — repeated cycles of 4 blinks and a pause.

◦

S5 (Soft Off) = LED is off.

SATA Power Management – Enables or disables SATA bus and/or device power management. Default is
enabled.
S5 Maximum Power Savings – Turns off power to all nonessential hardware when system is off to meet
EUP Lot 6 requirement of less than 0.5 Watt power usage. Default is disabled.
PCI Express Power Management – Sets Active State Power Management (ASPM) of the bus. ASPM lets you
set lower power modes that activate when the bus is not being used. Options are Disabled, LOs, L1, LOs
and L1. Default is ASPM Disabled.
Network Controller – Sets ASPM of the bus. ASPM lets you set lower power modes that activate when the
bus is not being used. Options are Disabled, LOs, L1, LOs and L1. Default is ASPM Disabled.
USB 3.0 Controller – Sets ASPM of the bus. ASPM lets you set lower power modes that activate when the
bus is not being used. Options are Disabled, LOs, L1, LOs and L1. Default is ASPM Disabled.

Thermal

Fan idle mode—This bar graph controls the minimum permitted fan speed.
NOTE:

This setting only changes the minimum fan speed. The fans are still automatically controlled.

Computer Setup—Advanced
NOTE: Support for specific Computer Setup options may vary depending on the hardware configuration.
Table 5-5 Computer Setup—Advanced (for advanced users)
Option

Heading

Power-On Options

Allows you to set:
●

POST mode (QuickBoot, Clear Memory, FullBoot, or FullBoot Every x Days).
◦

QuickBoot (default) = Do not clear memory or perform a memory test.

◦

FullBoot = Memory test (count) on cold boot. Clears memory on all boots.

◦

Clear Memory = No memory count on cold boot. Clears memory on all boots.

◦

FullBoot Every x Days = Memory count on 1st cold boot on or after the xth day. No more
memory counts until 1st cold boot on or after x days. Clears memory on all boots.

●

POST messages (enable/disable). Enabling this feature will cause the system to display POST error
messages, which are error messages displayed on the monitor during the Power On Self Test if the
BIOS encounters some kind of problem while starting the PC. A POST error message will only display
on screen if the computer is capable of booting this far. If the POST detects an error before this
point, a beep code is generated instead. Default is disabled.

●

Press the ESC key for Startup Menu (Enable/Disable). This feature controls the display of the text
“Press the ESC key for Startup Menu” during POST. This text does not display on Windows 8 systems
with Fast Boot support. Other text also will not display (for example, Ownership Tag). Default is
enabled.

●

Option ROM Prompt (enable/disable). Enabling this feature will cause the system to display a
message before loading option ROMs. Default is enabled.

●

After Power Loss (off/on/previous state). Default is Power off. Setting this option to:
◦

Power off—causes the computer to remain powered off when power is restored.

◦

Power on—causes the computer to power on automatically as soon as power is restored.
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Table 5-5 Computer Setup—Advanced (for advanced users) (continued)
◦

Previous state—causes the computer to power on automatically as soon as power is restored,
if it was on when power was lost.

NOTE: If you turn off power to the computer using the switch on a power strip, you will not be able to
use the suspend/sleep feature or the Remote Management features.
●

POST Delay (in seconds). Enabling this feature will add a user-specified delay to the POST process.
This delay is sometimes needed for hard disks on some PCI cards that spin up very slowly, so slowly
that they are not ready to boot by the time POST is finished. The POST delay also gives you more
time to select F10 to enter Computer (F10) Setup. Default is None.

●

Remote Wakeup Boot Source (remote server/local hard drive). Default is Local hard drive.

●

Factory Recovery Boot Support (Enable/Disable). Provides the ability for the BIOS to redirect the
boot to the recovery partition on the user hard drive, if present. Some versions of the recovery
software honor the F11 key press even when this feature is disabled by the BIOS. Default is
disabled.

●

Bypass F1 Prompt on Configuration Changes (Enable/Disable). Allows you to set the computer not
to confirm when changes were made. Default is disabled.

BIOS Power-On

Allows you to set the computer to turn on automatically at a time you specify.

Onboard Devices

Allows you to set resources for or disable Legacy devices.
Select the Legacy device's IRQ, DMA, and I/O Range. The settings may not take effect for all operating
systems. To hide a device from the operating system, see Security > Device Security.

Bus Options

Device Options

Allows you to enable or disable:
●

PCI SERR# Generation. Default is enabled.

●

PCI VGA Palette Snooping, which sets the VGA palette snooping bit in PCI configuration space; only
needed when more than one graphics controller is installed. Default is disabled.

Allows you to set:
●

Printer mode (Bi-Directional, EPP + ECP, Output Only). ECP = Enhanced Capabilities Port, EPP =
Enhanced Parallel Port. Default is EPP+ECP.

●

Num Lock State at Power-On (off/on). Default is off.

●

Integrated Video (enable/disable). Use this option to disable the integrated video controller when
another video controller is present in the system. Default is enabled.

●

Integrated Graphics (Auto/Disable/Force) Use this option to manage integrated (UMA) graphics
memory allocation. The value you choose is allocated permanently to graphics and is unavailable to
the operating system. For example, if you set this value to 512M on a system with 2 GB of RAM, the
system always allocates 512 MB for graphics and the other 1.5 GB for use by the BIOS and operating
system. Default is Auto which sets memory allocation to 512 MB.
If you select Force, the UMA Frame Buffer Size option displays, which lets you set the UMA memory
size allocation between 32 MB and 1 GB.
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●

Internal Speaker (does not affect external speakers). Default is enabled.

●

NIC PXE Option ROM Download (PXE, iSCSI, disabled). The BIOS contains an embedded NIC option
ROM to allow the unit to boot through the network to a PXE server. This is typically used to
download a corporate image to a hard drive. The NIC option ROM takes up memory space below 1MB
commonly referred to as DOS Compatibility Hole (DCH) space. This space is limited. This F10 option
will allow users to disable the downloading of this embedded NIC option ROM thus giving more DCH
space for additional PCI cards which may need option ROM space. The default will be to have the NIC
option-ROM-enabled. Default is PXE.

●

SATA RAID Option ROM Download (enable/disable). The BIOS contains an embedded SATA RAID
option ROM for RAID support. This can be temporarily disabled to save DCH space. Note that with
the option ROM disabled, users will be unable to boot to hard drives in the system while running in
RAID mode. Default is disabled.
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Table 5-5 Computer Setup—Advanced (for advanced users) (continued)
●

Multi-Processor (enable/disable). Use this option to disable multi-processor support under the OS.
Default is enabled.

●

Hyper threading (enable/disable). Use this option to disable processor hyper-threading.

●

Turbo Mode (enable/disable). Allows you to enable and disable the Intel Turbo Mode feature, which
allows one core of the system to run at a higher than standard frequency and power if other cores
are idle. Default is enabled.

VGA Configuration

Displayed only if there is an add-in video card in the system. Allows you to specify which VGA controller
will be the “boot” or primary VGA controller.

Option ROM Launch
Policy

Let you set the launch policy for option ROMs. An Option ROM typically consists of firmware that is called
by the system BIOS. For example, an adapter card that controls a boot device might contain firmware that
is used to connect the device to the system once the Option ROM is loaded.

AMT Configuration

●

PXE Option ROMs (legacy only/EFI only/do not launch)

●

Storage Option ROMs (legacy only/EFI only/do not launch)

●

Video Option ROMs (legacy only/EFI only)

●

NetClone Option ROMs (legacy only/do not launch)

Allows you to set:
●

AMT (enable/disable). Allows you to enable or disable functions of the embedded Management
Engine (ME) such as Active Management Technology (AMT). If set to disable, the Management
Engine is set to a temporarily disabled state and will not provide functions beyond necessary
system configuration. Default is enabled.

●

Unconfigure AMT/ME (enable/disable). Allows you to unconfigure any provisioned management
settings for AMT. The AMT settings are restored to factory defaults. This feature should be used
with caution as AMT will not be able to provide any set AMT management functions once
unconfigured. Default is disabled.

●

Hide Unconfigure ME Confirmation Prompt (enable/disable). Allows you to set the system to not
display the confirmation to unconfigure ME.

●

Watchdog Timer (enable/disable). Allows you to set amount of time for a operating system and
BIOS watchdog alert to be sent if the timers are not deactivated. BIOS watchdog is deactivated by
BIOS and would indicate that a halt occurred during execution if the alert is sent to the management
console. An operating system alert is deactivated by the operating system image and would indicate
that a hang occurred during its initialization. Default is enabled.

Recovering the Configuration Settings
This method of recovery requires that you first perform the Save to Removable Media command with the
Computer Setup (F10) Utility before Restore is needed. (See Computer Setup—File on page 63 in the
Computer Setup—File table.)
NOTE: It is recommended that you save any modified computer configuration settings to a USB flash media
device and save the device for possible future use.
To restore the configuration, insert the USB flash media device with the saved configuration and perform the
Restore from Removable Media command with the Computer Setup (F10) Utility. (See Computer Setup—File
on page 63 in the Computer Setup—File table.)

Recovering the Configuration Settings
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6

Troubleshooting without diagnostics
This chapter provides information on how to identify and correct minor problems, such as USB devices, hard
drive, optical drive, graphics, audio, memory, and software problems. If you encounter problems with the
computer, refer to the tables in this chapter for probable causes and recommended solutions.
NOTE: For information on specific error messages that may appear on the screen during Power-On SelfTest (POST) at startup, refer to Appendix A, POST error messages on page 105.

Safety and comfort
WARNING! Misuse of the computer or failure to establish a safe and comfortable work environment may
result in discomfort or serious injury. Refer to the Safety & Comfort Guide at http://www.hp.com/ergo for
more information on choosing a workspace and creating a safe and comfortable work environment. For more
information, refer to the Safety & Regulatory Information guide.

Before you call for technical support
If you are having problems with the computer, try the appropriate solutions below to try to isolate the exact
problem before calling for technical support.
●

Run the HP diagnostic tool.

●

Run the hard drive self-test in Computer Setup. Refer to Computer Setup (F10) Utility on page 61 for
more information.

●

Check the Power LED on the front of the computer to see if it is flashing red. The flashing lights are error
codes that will help you diagnose the problem. Refer to Appendix A, POST error messages on page 105
for more information.

●

If the screen is blank, plug the monitor into a different video port on the computer if one is available. Or,
replace the monitor with a monitor that you know is functioning properly.

●

If you are working on a network, plug another computer with a different cable into the network
connection. There may be a problem with the network plug or cable.

●

If you recently added new hardware, remove the hardware and see if the computer functions properly.

●

If you recently installed new software, uninstall the software and see if the computer functions
properly.

●

Boot the computer to the Safe Mode to see if it will boot without all of the drivers loaded. When booting
the operating system, use “Last Known Configuration.”

●

Refer to the comprehensive online technical support at http://www.hp.com/support.

●

Refer to Helpful hints on page 73 in this guide.

To assist you in resolving problems online, HP Instant Support Professional Edition provides you with selfsolve diagnostics. If you need to contact HP support, use HP Instant Support Professional Edition's online
chat feature. Access HP Instant Support Professional Edition at: http://www.hp.com/go/ispe.
Access the Business Support Center (BSC) at http://www.hp.com/go/bizsupport for the latest online support
information, software and drivers, proactive notification, and worldwide community of peers and HP experts.
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If it becomes necessary to call for technical assistance, be prepared to do the following to ensure that your
service call is handled properly:
●

Be in front of your computer when you call.

●

Write down the computer serial number, product ID number, and monitor serial number before calling.

●

Spend time troubleshooting the problem with the service technician.

●

Remove any hardware that was recently added to your system.

●

Remove any software that was recently installed.

●

Restore the system from the Recovery Disc Set that you created or restore the system to its original
factory condition in System Software Requirement Disks (SSRD).

CAUTION: Restoring the system will erase all data on the hard drive. Be sure to back up all data files before
running the restore process.
NOTE: For sales information and warranty upgrades (Care Packs), call your local authorized service
provider or dealer.

Helpful hints
If you encounter problems with the computer, monitor, or software, see the following list of general
suggestions before taking further action:
●

Check that the computer and monitor are plugged into a working electrical outlet.

●

Check that the voltage select switch (some models) is set to the appropriate voltage for your region
(115V or 230V).

●

Check that the computer is turned on and the white power light is on.

●

Check that the monitor is turned on and the green monitor light is on.

●

Check the Power LED on the front of the computer to see if it is flashing red. The flashing lights are error
codes that will help you diagnose the problem. Refer to Appendix A, POST error messages on page 105
for more information.

●

Turn up the brightness and contrast controls of the monitor if the monitor is dim.

●

Press and hold any key. If the system beeps, then the keyboard should be operating correctly.

●

Check all cable connections for loose connections or incorrect connections.

●

Wake the computer by pressing any key on the keyboard or pressing the power button. If the system
remains in suspend mode, shut down the computer by pressing and holding the power button for at
least four seconds then press the power button again to restart the computer. If the system will not
shut down, unplug the power cord, wait a few seconds, then plug it in again. The computer will restart if
it is set to power on automatically as soon as power is restored in Computer Setup. If it does not restart,
press the power button to start the computer.

●

Reconfigure the computer after installing a non-plug and play expansion board or other option. See
Solving Hardware Installation Problems on page 91 for instructions.

●

Be sure that all the needed device drivers have been installed. For example, if you are using a printer,
you need a driver for that model printer.

●

Remove all bootable media (CD/DVD or USB device) from the system before turning it on.

Helpful hints
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●

If you have installed an operating system other than the factory-installed operating system, check to be
sure that it is supported on the system.

●

If the system has multiple video sources (embedded, PCI, or PCI-Express adapters) installed (embedded
video on some models only) and a single monitor, the monitor must be plugged into the monitor
connector on the source selected as the primary VGA adapter. During boot, the other monitor
connectors are disabled and if the monitor is connected into these ports, the monitor will not function.
You can select which source will be the default VGA source in Computer Setup.

CAUTION: When the computer is plugged into an AC power source, there is always voltage applied to the
system board. You must disconnect the power cord from the power source before opening the computer to
prevent system board or component damage.

Solving general problems
You may be able to easily resolve the general problems described in this section. If a problem persists and
you are unable to resolve it yourself or if you feel uncomfortable about performing the operation, contact an
authorized dealer or reseller.
WARNING! When the computer is plugged into an AC power source, voltage is always applied to the system
board. To reduce the risk of personal injury from electrical shock and/or hot surfaces, be sure to disconnect
the power cord from the wall outlet and allow the internal system components to cool before touching.
Computer appears locked up and will not turn off when the power button is pressed.
Cause

Solution

Software control of the power switch is not functional.

1.

Press and hold the power button for at least four seconds
until the computer turns off.

2.

Disconnect the power cord from the electrical outlet.

Computer will not respond to keyboard or mouse.
Cause

Solution

Computer is in Sleep state.

To resume from Sleep state, press the power button.
CAUTION: When attempting to resume from Sleep state, do not
hold down the power button for more than four seconds.
Otherwise, the computer will shut down and you will lose any
unsaved data.

System has locked up.

Restart computer.

Computer date and time display is incorrect.
Cause

Solution

RTC (real-time clock) battery may need to be replaced.

Reset the date and time under Control Panel (Computer Setup
can also be used to update the RTC date and time). If the problem
persists, replace the RTC battery. See the Removal and
Replacement section for instructions on installing a new battery,
or contact an authorized dealer or reseller for RTC battery
replacement.

NOTE: Connecting the computer to a live AC outlet prolongs the
life of the RTC battery.
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Computer date and time display is incorrect.
Cause

Solution
To access Control Panel in Windows 7, select Start, and then
select Control Panel.
To access Control Panel in Windows 8, from the Start screen, type
c, and then select Control Panel from the list of applications.

Cursor will not move using the arrow keys on the keypad.
Cause

Solution

The Num Lock key is turned on.

Press the Num Lock key. The Num Lock light must be off if you
want to use the arrow keys on the keypad. You can also disable or
enable the Num Lock key in Computer Setup at Advanced >
Device Options.

There is no sound or sound volume is too low.
Cause

Solution

System volume may be set low or muted.

1.

Check the Computer Setup settings to make sure the
internal system speaker is not muted (this setting does not
affect the external speakers).

2.

Make sure the external speakers are properly connected
and powered on and that the speakers' volume control is set
correctly.

3.

Use the system volume control available in the operating
system to make sure the speakers are not muted or to
increase the volume.

Cannot remove computer cover or access panel.
Cause

Solution

Smart Cover Lock, featured on some computers, is locked.

Unlock the Smart Cover Lock using Computer Setup.
In case of forgotten password, power loss, or computer
malfunction, you must manually disable the Smart Cover lock . A
key to unlock the Smart Cover Lock is not available from HP. Keys
are typically available from a hardware store.

Poor performance.
Cause

Solution

Processor is too hot.

1.

Make sure airflow to the computer is not blocked. Leave a
10.2-cm (4-inch) clearance on all vented sides of the
computer and above the monitor to permit the required
airflow.

2.

Make sure fans are connected and working properly (some
fans only operate when needed).
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Poor performance.
Cause

Solution
3.

Make sure the processor heat sink is installed properly.

Hard drive is full.

Transfer data from the hard drive to create more space on the
hard drive.

Low on memory.

Add more memory.

Hard drive fragmented.

Defragment hard drive.

Program previously accessed did not release reserved memory
back to the system.

Restart the computer.

Virus resident on the hard drive.

Run virus protection program.

Too many applications running.

Windows 7:
1.

Close unnecessary applications to free up memory.

2.

Add more memory.

3.

Some applications run in the background and can be closed
by right-clicking on their corresponding icons in the task
tray. To prevent these applications from launching at
startup:
In Windows 7:
a.

Go to Start > All Programs > Accessories > Run

b.

Type msconfig, and then press Enter.

c.

On the Startup tab of the System Configuration Utility,
clear applications that you do not want to launch
automatically, and the click OK.

In Windows 8:

Some software applications, especially games, are stressful on
the graphics subsystem.

Cause unknown.
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a.

On the Start screen, right-click, and then select the All
apps icon.

b.

Under Windows System, click Run.

c.

Type msconfig, and then press Enter.

d.

On the Startup tab of the System Configuration Utility,
clear applications that you do not want to launch
automatically, and the click OK.

1.

Lower the display resolution for the current application or
consult the documentation that came with the application
for suggestions on how to improve performance by
adjusting parameters in the application.

2.

Add more memory.

3.

Upgrade the graphics solution.

Restart the computer.

Computer powered off automatically and the Power LED flashes Red two times, once every second, followed by a two second
pause, and the computer beeps two times. (Beeps stop after fifth iteration but LEDs continue flashing).
Cause

Solution

Processor thermal protection activated:

1.

Ensure that the computer air vents are not blocked and the
processor cooling fan is running.

2.

Open the access panel, press the power button, and see if
the processor fan (or other system fan) spins. If the fan does
not spin, make sure the fan cable is plugged onto the
system board header.

3.

If fan a plugged in and not spinning, replace it.

A fan may be blocked or not turning.
OR
The heat sink is not properly attached to the processor.

System does not power on and the LEDs on the front of the computer are not flashing.
Cause

Solution

System unable to power on.

Press and hold the power button for less than 4 seconds. If the
hard drive LED turns white, then:
1.

If equipped with a voltage selector, check that the voltage
selector (located on the rear of the power supply) is set to
the appropriate voltage. Proper voltage setting depends on
your region.

2.

Remove the expansion cards one at a time until the 5V_aux
light on the system board turns on.

3.

Replace the system board.

OR
Press and hold the power button for less than 4 seconds. If the
hard drive LED does not turn on white then:
1.

Check that the unit is plugged into a working AC outlet.

2.

Open the access panel and check that the power button
cable is properly connected to the system board.

3.

Check that the power supply cables are properly connected
to the system board.

4.

Check to see if the 5V_aux light on the system board is
turned on. If it is turned on, then replace the power button
assembly.

5.

If the 5V_aux light on the system board is off, then replace
the power supply.

6.

Replace the system board.
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Solving power problems
Common causes and solutions for power problems are listed in the following table.
Power supply shuts down intermittently.
Cause

Solution

If equipped with a voltage selector, voltage selector switch on
rear of computer chassis (some models) not switched to correct
line voltage (115V or 230V).

Select the proper AC voltage using the selector switch.

Power supply will not turn on because of internal power supply
fault.

Replace the power supply.

Computer powered off automatically and the Power LED flashes Red two times, once every second, followed by a two second
pause, and the computer beeps two times. (Beeps stop after fifth iteration but LEDs continue flashing.)
Cause

Solution

Processor thermal protection activated:

1.

Ensure that the computer air vents are not blocked and the
processor cooling fan is running.

2.

Open the access panel, press the power button, and see if
the processor fan (or other system fan) spins. If the fan does
not spin, make sure the fan cable is plugged onto the
system board header.

3.

If fan a plugged in and not spinning, replace it.

A fan may be blocked or not turning.
OR
The heat sink is not properly attached to the processor.

Power LED flashes Red four times, once every second, followed by a two second pause, and the computer beeps four times.
(Beeps stop after fifth iteration but LEDs continue flashing.)
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Cause

Solution

Power failure (power supply is overloaded).

1.

If equipped with a voltage selector, check that the voltage
selector, located on the rear of the power supply (some
models), is set to the appropriate voltage. Proper voltage
setting depends on your region.

2.

Open the access panel and ensure the power supply cable is
seated into the connector on the system board.

3.

Check if a device is causing the problem by removing ALL
attached devices (such as hard drives or optical drives and
expansion cards). Power on the system. If the system enters
POST, then power off and replace one device at a time and
repeat this procedure until failure occurs. Replace the
device that is causing the failure. Continue adding devices
one at a time to ensure all devices are functioning properly.

4.

Replace the power supply.

5.

Replace the system board.
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Solving hard drive problems
Hard drive error occurs.
Cause

Solution

Hard disk has bad sectors or has failed.

1.

In Windows 7, click Start, click Computer, and right-click on
a drive. Select Properties, and then select the Tools tab.
Under Error-checking click Check Now.
In Windows 8, on the Start screen type e, and then select
File Explorer from the list of applications. In the left
column, expand Computer, right-click on a drive, select
Properties, and then select the Tools tab. Under Error
checking click Check.

2.

Use a utility to locate and block usage of bad sectors. If
necessary, reformat the hard disk.

Disk transaction problem.
Cause

Solution

Either the directory structure is bad or there is a problem with a
file.

In Windows 7, click Start, expand Computer, and right-click on a
drive. Select Properties, and then select the Tools tab. Under
Error-checking click Check Now.
In Windows 8, on the Start screen type e, and then click File
Explorer from the list of applications. In the left column, expand
Computer, right-click on a drive, select Properties, and then
select the Tools tab. Under Error checking click Check.

Drive not found (identified).
Cause

Solution

Cable could be loose.

Check cable connections.

The system may not have automatically recognized a newly
installed device.

See reconfiguration directions in the Solving Hardware
Installation Problems on page 91 section. If the system still
does not recognize the new device, check to see if the device is
listed within Computer Setup. If it is listed, the probable cause is a
driver problem. If it is not listed, the probable cause is a hardware
problem.
If this is a newly installed drive, run the Computer Setup utility
and try adding a POST delay under Advanced > Power-On
Options.

The device is attached to a SATA port that has been hidden in
Computer Setup.

Run the Computer Setup utility and ensure Device Available is
selected for the device's SATA port in Security > Device Security.

Drive responds slowly immediately after power-up.

Run Computer Setup and increase the POST Delay in Advanced >
Power-On Options.
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79

Nonsystem disk/NTLDR missing message.
Cause

Solution

The system is trying to start from the hard drive but the hard
drive may have been damaged.

▲

Perform Drive Protection System (DPS) testing in system
ROM.

System files missing or not properly installed.

1.

Insert bootable media and restart the computer.

2.

Boot to the windows installation media and select the
recovery option. If only a restore kit is available, then select
the File Backup Program option, and then restore the
system.

3.

Install system files for the appropriate operating system.

Hard drive boot has been disabled in Computer Setup.

Run the Computer Setup utility and enable the hard drive entry in
the Storage > Boot Order list.

Bootable hard drive is not attached as first in a multi-hard drive
configuration.

If attempting to boot from a hard drive, ensure it is attached to
the system board dark blue SATA connector.

Bootable hard drive is not listed first in the Boot Order.

Run the Computer Setup utility and select Storage > Boot Order
and ensure the bootable hard drive is listed immediately under
the Hard Drive entry.

Computer will not boot from hard drive.
Cause

Solution

The device is attached to a SATA port that has been hidden in
Computer Setup.

1.

Check SATA cable connections.

2.

Run the Computer Setup utility and ensure Device Available
is selected for the device's SATA port in Security > Device
Security.

Boot order is not correct.

Run the Computer Setup utility and change boot sequence in
Storage > Boot Order.

Hard Drive's “Emulation Type” is set to “None.” (some models)

Run the Computer Setup utility and change the “Emulation Type”
to “Hard Disk” in the device's details under Storage > Device
Configuration.

Hard drive is damaged.

Observe if the front panel Power LED is blinking RED and if any
beeps are heard. See Appendix A, POST error messages
on page 105 to determine possible causes for the blinking red
and beep codes.
See the Worldwide Limited Warranty for terms and conditions.

Computer seems to be locked up.
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Cause

Solution

Program in use has stopped responding to commands.

1.

Use the task manager to close programs that do not
respond.

2.

Attempt the normal Windows “Shut Down” procedure. If this
fails, press the power button for four or more seconds to
turn off the power. To restart the computer, press the
power button again.
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Solving media card reader problems
Media card will not work in a digital camera after formatting it in Windows.
Cause

Solution

By default, Windows will format any media card with a capacity
greater than 32MB with the FAT32 format. Some digital cameras
use the FAT (FAT16 & FAT12) format and can not operate with a
FAT32 formatted card.

Either format the media card in the digital camera or select FAT
file system to format the media card in a computer with Windows.

A write-protected or locked error occurs when attempting to write to the media card.
Cause

Solution

Media card is locked. Locking the media card is a safety feature
that prevents writing to and deleting from an SD/Memory Stick/
PRO card.

If using an SD card, make sure that the lock tab located on the
right of the SD card is not in the locked position. If using a
Memory Stick/PRO card, make sure that the lock tab located on
the bottom of the Memory Stick/PRO card is not in the locked
position.

Can not write to the media card.
Cause

Solution

The media card is a read-only memory (ROM) card.

Check the manufacturer’s documentation included with your card
to see if it writable. Refer to the previous section for a list of
compatible cards.

Media card is locked. Locking the media card is a safety feature
that prevents writing to and deleting from an SD/Memory Stick/
PRO card.

If using an SD card, make sure that the lock tab located on the
right of the SD card is not in the locked position. If using a
Memory Stick/PRO card, make sure that the lock tab located on
the bottom of the Memory Stick/PRO card is not in the locked
position.

Unable to access data on the media card after inserting it into a slot.
Cause

Solution

The media card is not inserted properly, is inserted in the wrong
slot, or is not supported.

Ensure that the card is inserted properly with the gold contact on
the correct side. The green LED will light if inserted properly.

Do not know how to remove a media card correctly.
Cause

Solution

The computer’s software is used to safely eject the card.

In Windows 7, click Start, select Computer, right-click on the
corresponding drive icon, and then select Eject. Pull the card out
of the slot.
In Windows 8, on the Start screen, type e, and then click File
Explorer from the list of applications. Expand Computer, rightclick on the corresponding drive icon, and then select Eject. Pull
the card out of the slot.
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Do not know how to remove a media card correctly.
Cause

Solution
NOTE:

Never remove the card when the green LED is flashing

After installing the media card reader and booting to Windows, the reader and the inserted cards are not recognized by the
computer.
Cause

Solution

The operating system needs time to recognize the device if the
reader was just installed into the computer and you are turning
the PC on for the first time.

Wait a few seconds so that the operating system can recognize
the reader and the available ports, and then recognize the media
inserted in the reader.

After inserting a media card in the reader, the computer attempts to boot from the media card.
Cause

Solution

The inserted media card has boot capability.

1.

If you do not want to boot from the media card, remove it
during boot or do not select the option to boot from the
inserted media card during the boot process.

2.

During POST (Power On Self-Test), press F9 to modify the
boot menu.

3.

Change the boot sequence in F10 Computer Setup.

Solving display problems
If you encounter display problems, see the documentation that came with the monitor and to the common
causes and solutions listed in the following table.
Blank screen (no video).
Cause

Solution

Monitor is not turned on and the monitor light is not on.

Turn on the monitor and check that the monitor light is on.

Bad monitor.

Try a different monitor.

The cable connections are not correct.

Check the cable connection from the monitor to the computer and
to the electrical outlet.

You may have a screen blanking utility installed or energy saver
features are enabled.

Press any key or click the mouse button and type your password
(if set).

System ROM is corrupted; system is running in Boot Block
Emergency Recovery Mode (indicated by eight beeps).

Reflash the system ROM with the latest BIOS image.

You are using a fixed-sync monitor and it will not sync at the
resolution chosen.

Be sure that the monitor can accept the same horizontal scan rate
as the resolution chosen.

Computer is in Sleep state.

Press the power button to resume from Sleep state.
CAUTION: When attempting to resume from Sleep state, do not
hold down the power button for more than four seconds.
Otherwise, the computer will shut down and you will lose any
unsaved data.
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Blank screen (no video).
Cause

Solution

Monitor cable is plugged into the wrong connector.

Systems may have a monitor connection on both the
motherboard or an add-in card. Try moving the monitor
connection to a different connector on the back of the computer

Monitor settings in the computer are not compatible with the
monitor.

1.

In Control Panel, select Category from the View by list, then
under Appearance and Personalization, select Adjust
screen resolution.
To access Control Panel in Windows 7, click Start, and then
select Control Panel.
To access Control Panel in Windows 8, from the Start
screen, type c, and then select Control Panel from the list
of applications.

2.
Monitor is configured to use an input that is not active.

Expand the Resolution box, and then use the sliding control
to reset the resolution.

Use the monitor's on-screen menu controls to select the input
that is being driven by the system. Refer to the monitor's user
documentation for more information on the on-screen controls
and settings.

Blank screen and the power LED flashes Red five times, once every second, followed by a two second pause, and the computer
beeps five times. (Beeps stop after fifth iteration but LEDs continue flashing.)
Cause

Solution

Pre-video memory error.

1.

Reseat DIMMs. Power on the system.

2.

Replace DIMMs one at a time to isolate the faulty module.

3.

Replace third-party memory with HP memory.

4.

Replace the system board.

Blank screen and the power LED flashes Red six times, once every second, followed by a two second pause, and the computer
beeps six times. (Beeps stop after fifth iteration but LEDs continue flashing.)
Cause

Solution

Pre-video graphics error.

For systems with a graphics card:
1.

Reseat the graphics card (if applicable). Power on the
system.

2.

Replace the graphics card (if applicable).

3.

Replace the system board.

For systems with integrated graphics, replace the system board.
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Blank screen and the power LED flashes Red seven times, once every second, followed by a two second pause, and the computer
beeps seven times. (Beeps stop after fifth iteration but LEDs continue flashing.)
Cause

Solution

System board failure (ROM detected failure prior to video).

Replace the system board.

Monitor does not function properly when used with energy saver features.
Cause

Solution

Monitor without energy saver capabilities is being used with
energy saver features enabled.

Disable monitor energy saver feature.

Dim characters.
Cause

Solution

The brightness and contrast controls are not set properly.

Adjust the monitor brightness and contrast controls.

Cables are not properly connected.

Check that the graphics cable is securely connected to the
graphics card (if applicable) or video connector and the monitor.

Blurry video or requested resolution cannot be set.
Cause

Solution

If the graphics controller was upgraded, the correct graphics
drivers may not be loaded.

Install the video drivers included in the upgrade kit.

Monitor is not capable of displaying requested resolution.

Change requested resolution.

Graphics card is bad.

Replace the graphics card.

The picture is broken up, rolls, jitters, or flashes.
Cause

Solution

The monitor connections may be incomplete or the monitor may
be incorrectly adjusted.

1.

Be sure the monitor cable is securely connected to the
computer.

2.

In a two-monitor system or if another monitor is in close
proximity, be sure the monitors are not interfering with
each other’s electromagnetic field by moving them apart.

3.

Fluorescent lights or fans may be too close to the monitor.

Monitor needs to be degaussed.
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Degauss the monitor. Refer to the documentation that came with
the monitor for instructions.

Image is not centered.
Cause

Solution

Position may need adjustment.

Press the monitor's Menu button to access the OSD menu. Select
ImageControl/ Horizontal Position or Vertical Position to adjust
the horizontal or vertical position of the image.

“No Connection, Check Signal Cable” displays on screen.
Cause

Solution

Monitor video cable is disconnected.

Connect the video cable between the monitor and computer.
CAUTION: Ensure that the computer power is off while
connecting the video cable.

“Out of Range” displays on screen.
Cause

Solution

Video resolution and refresh rate are set higher than what the
monitor supports.

Restart the computer and enter Safe Mode. Change the settings
to a supported setting then restart the computer so that the new
settings take effect.
To enter Safe Mode in Windows 7:
1.

Restart the computer.

2.

Press and hold the F8 key as your computer restarts, before
the Windows logo appears. If the Windows logo appears,
you must restart the computer and try again.

3.

On the Advanced Boot Options screen, use the arrow keys to
highlight the safe mode option you want, and then press
Enter.

4.

Log on to your computer with a user account that has
administrator rights.
When your computer is in safe mode, Safe Mode displays in
the corners of your monitor. To exit safe mode, restart your
computer and let Windows start normally.

To enter Safe Mode in Windows 8:
1.

Press the Windows logo + l to open the Settings charm.

2.

Select Change PC Settings, select General, and then under
Advanced startup, click Restart now.

3.

Select Troubleshoot, select Advanced options, select
Startup Settings, and then click Restart.

4.

Use the function keys or number keys to select the safe
mode option you want.
When your computer is in safe mode, Safe Mode displays in
the corners of your monitor. To exit safe mode, restart your
computer and let Windows start normally.
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High pitched noise coming from inside a flat panel monitor.
Cause

Solution

Brightness and/or contrast settings are too high.

Lower brightness and/or contrast settings.

Fuzzy focus; streaking, ghosting, or shadowing effects; horizontal scrolling lines; faint vertical bars; or unable to center the
picture on the screen (flat panel monitors using an analog VGA input connection only).
Cause

Solution

Flat panel monitor’s internal digital conversion circuits may be
unable to correctly interpret the output synchronization of the
graphics card.

1.

Select the monitor’s Auto-Adjustment option in the
monitor’s on-screen display menu.

2.

Manually synchronize the Clock and Clock Phase on-screen
display functions. To download a SoftPaq that will assist
you with the synchronization, go to the following Web site,
select the appropriate monitor, and download either
SP32347 or SP32202: http://www.hp.com/support

Graphics card is not seated properly or is bad (some models).

1.

Reseat the graphics card.

2.

Replace the graphics card.

Certain typed symbols do not appear correct.
Cause

Solution

The font you are using does not support that particular symbol.

Use the Character Map to locate and select the appropriate
symbol. You can copy the symbol from the Character Map into a
document.
In Windows 7, click Start, select All Programs, select
Accessories, select System Tools, and then select Character
Map.
In Windows 8, on the Start screen, type ch, and then select
Character Map from the list of applications.

Solving audio problems
If the computer has audio features and you encounter audio problems, see the common causes and solutions
listed in the following table.
Sound cuts in and out.
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Cause

Solution

Processor resources are being used by other open applications.

Shut down all open processor-intensive applications.
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Sound does not come out of the speaker or headphones.
Cause

Solution

Software volume control is turned down or muted.

Double-click the Speaker icon on the taskbar, then make sure
that Mute is not selected and use the volume slider to adjust the
volume.
NOTE: In Windows 8, the taskbar is available at the bottom of
the Desktop screen.

Audio is hidden in Computer Setup.

Enable the audio in Computer Setup: Security > Device Security >
System Audio.

The external speakers are not turned on.

Turn on the external speakers.

The audio device may be connected to the wrong jack.

Ensure that the device is connected to the correct jack on the
computer. The rear audio jack output is the green receptacle. The
speakers should be plugged into the line-out jack and the
headphones should be plugged into the headphone jack.

External speakers plugged into the wrong audio jack on a recently
installed sound card.

See the sound card documentation for proper speaker
connection. The rear audio jack output is the green receptacle.

Headphones or devices connected to the line-out connector mute
the internal speaker.

Turn on and use headphones or external speakers, if connected,
or disconnect headphones or external speakers.

Computer is in Sleep state.

Press the power button to resume from Sleep state.
CAUTION: When attempting to resume from Sleep state, do not
hold down the power button for more than four seconds.
Otherwise, the computer will shut down and you will lose any
unsaved data.

Internal speaker is disabled in Computer Setup.

Enable the internal speaker in Computer Setup. Select Advanced
> Device Options > Internal Speaker.

The application is set to use a different audio device than
speakers.

Some graphics cards support audio over the DisplayPort
connection (if applicable), so multiple audio devices may be listed
in Device Manager. Make sure the correct device is being used.
To access Device Manager in Windows 7, click Start, select
Control Panel, and then select Device Manager.
To access Device Manager in Windows 8, from the Start screen,
type c, select Control Panel from the list of applications, and then
select Device Manager.

Some applications can select which audio output device is used.

Make sure the application has selected the correct audio device.

The operating system controls may be set to use a different audio
device as the default output device than what is expected.

Set the operating system to use the correct audio device.

Sound from headphones is not clear or muffled.
Cause

Solution

Headphones are plugged into the rear audio output connector.
The rear audio output connector is for powered audio devices and
is not designed for headphone use.

Plug the headphones into the headphone connector on the front
of the computer.
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Computer appears to be locked up while recording audio.
Cause

Solution

The hard disk may be full.

Before recording, make sure there is enough free space on the
hard disk. You can also try recording the audio file in a
compressed format.

Line-in jack is not functioning properly.
Cause

Solution

Jack has been reconfigured in the audio driver or application
software.

In the audio driver or application software, reconfigure the jack or
set the jack to its default value.

There is no sound or sound volume is too low.
Cause

Solution

The application is set to use a different audio device than
speakers.

Some graphics cards support audio over the DisplayPort
connection (if applicable), so multiple audio devices may be listed
in Device Manager. Make sure the correct device is being used.
To access Device Manager in Windows 7, click Start, select
Control Panel, and then select Device Manager.
To access Device Manager in Windows 8, from the Start screen,
type c, select Control Panel from the list of applications, and then
select Device Manager.

Some applications can select which audio output device is used.

Make sure the application has selected the correct audio device.

The operating system controls may be set to use a different audio
device as the default output device than what is expected.

Set the operating system to use the correct audio device.

Solving printer problems
If you encounter printer problems, see the documentation that came with the printer and to the common
causes and solutions listed in the following table.
Printer will not print.
Cause

Solution

Printer is not turned on and online.

Turn the printer on and make sure it is online.

The correct printer drivers for the application are not installed.

1.

Install the correct printer driver for the application.

2.

Try printing using the MS-DOS command:

DIR C:\ > [printer port]
where [printer port] is the address of the printer being
used. If the printer works, reload the printer driver.
To run MS-DOS commands, press the Windows key + r, type cmd
in the Open box, and then click OK.
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Printer will not print.
Cause

Solution

If you are on a network, you may not have made the connection
to the printer.

Make the proper network connections to the printer.

Printer may have failed.

Run printer self-test.

Printer will not turn on.
Cause

Solution

The cables may not be connected properly.

Reconnect all cables and check the power cord and electrical
outlet.

Printer prints garbled information.
Cause

Solution

The correct printer driver for the application is not installed.

Install the correct printer driver for the application.

The cables may not be connected properly.

Reconnect all cables.

Printer memory may be overloaded.

Reset the printer by turning it off for one minute, then turn it back
on.

Printer will not print.
Cause

Solution

The printer may be out of paper.

Check the paper tray and refill it if it is empty.

Solving keyboard and mouse problems
If you encounter keyboard or mouse problems, see the documentation that came with the equipment and to
the common causes and solutions listed in the following table.
A wireless keyboard/mouse is not working correctly. Symptoms include lagging mouse movement, jumpy mouse/keyboard, or no
function of mouse/keyboard and external drive.
Cause

Solution

If your computer is equipped with USB 3.0 ports, connected USB
3.0 devices can interfere with the wireless keyboard USB receiver.

Connect the wireless keyboard USB receiver to a USB 2.0 port that
is separated from ports with USB 3.0 devices. If you still
experience interference, you may have to place the connectors
farther apart using an external USB hub.
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Keyboard commands and typing are not recognized by the computer.
Cause

Solution

Keyboard connector is not properly connected.

Shut down the computer, reconnect the keyboard to the back of
the computer, and then restart the computer.

Program in use has stopped responding to commands.

Shut down your computer using the mouse and then restart the
computer.

Keyboard needs repairs.

See the Worldwide Limited Warranty for terms and conditions.

Computer is in Sleep state.

Press the power button to resume from Sleep state.
CAUTION: When attempting to resume from Sleep date, do not
hold down the power button for more than four seconds.
Otherwise, the computer will shut down and you will lose any
unsaved data.

Cursor will not move using the arrow keys on the keypad.
Cause

Solution

The Num Lock key is on.

Press the Num Lock key. The Num Lock light should be off if you
want to use the arrow keys on the keypad. You can disable or
enable the Num Lock key in Computer Setup at Advanced >
Device Options.

Mouse does not respond to movement or is too slow.
Cause

Solution

Mouse connector is not properly plugged into the back of the
computer.

Shut down the computer using the keyboard.
Windows 7:
1.

Press the Ctrl and Esc keys at the same time (or press the
Windows logo key) to display the Start menu.

2.

Use the arrow keys to select Shut Down and then press
Enter.

3.

After the shutdown is complete, plug the mouse connector
into the back of the computer (or the keyboard) and restart.

Windows 8:
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1.

Press the Windows logo + l to open the Settings charm.

2.

Use the arrow keys to select Power, and then press Enter.

3.

Use the arrow keys to select Shut Down, and then press
Enter.

4.

After the shutdown is complete, plug the mouse connector
into the back of the computer (or the keyboard) and restart.

Program in use has stopped responding to commands.

Shut down the computer using the keyboard then restart the
computer.

Mouse may need cleaning.

Remove the roller ball cover on the mouse and clean the internal
components.
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Mouse does not respond to movement or is too slow.
Cause

Solution

Mouse may need repair.

See the Worldwide Limited Warranty for terms and conditions.

Computer is in Sleep state.

Press the power button to resume from Sleep state.
CAUTION: When attempting to resume from Sleep state, do not
hold down the power button for more than four seconds.
Otherwise, the computer will shut down and you will lose any
unsaved data.

Mouse will only move vertically, horizontally, or movement is jerky.
Cause

Solution

Mouse roller ball or the rotating encoder shafts that make
contact with the ball are dirty.

Remove roller ball cover from the bottom of the mouse and clean
the internal components with a mouse cleaning kit available from
most computer stores.

Solving Hardware Installation Problems
You may need to reconfigure the computer when you add or remove hardware, such as an additional drive or
expansion card. If you install a plug and play device, Windows automatically recognizes the device and
configures the computer. If you install a non-plug and play device, you must reconfigure the computer after
completing installation of the new hardware. In Windows, use the Add Hardware Wizard and follow the
instructions that appear on the screen.
To open the Add Hardware Wizard, open a Command Prompt and open hdwwiz.exe.
WARNING! When the computer is plugged into an AC power source, voltage is always applied to the system
board. To reduce the risk of personal injury from electrical shock and/or hot surfaces, be sure to disconnect
the power cord from the wall outlet and allow the internal system components to cool before touching.
Table 6-1 Solving Hardware Installation Problems
A new device is not recognized as part of the system.
Cause

Solution

Device is not seated or connected properly.

Ensure that the device is properly and securely connected and
that pins in the connector are not bent down.

Cable(s) of new external device are loose or power cables are
unplugged.

Ensure that all cables are properly and securely connected and
that pins in the cable or connector are not bent down.

Power switch of new external device is not turned on.

Turn off the computer, turn on the external device, then turn on
the computer to integrate the device with the computer system.

When the system advised you of changes to the configuration,
you did not accept them.

Reboot the computer and follow the instructions for accepting
the changes.

A plug and play board may not automatically configure when
added if the default configuration conflicts with other devices.

Use Windows Device Manager to deselect the automatic settings
for the board and choose a basic configuration that does not
cause a resource conflict. You can also use Computer Setup to
reconfigure or disable devices to resolve the resource conflict.
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Table 6-1 Solving Hardware Installation Problems (continued)
A new device is not recognized as part of the system.
Cause

Solution
To access Device Manager in Windows 7, click Start, select
Control Panel, and then select Device Manager.
To access Device Manager in Windows 8, from the Start screen,
type c, select Control Panel from the list of applications, and then
select Device Manager.

USB ports on the computer are disabled in Computer Setup.

Run the Computer Setup utility and ensure that Device available
is selected for appropriate USB ports under Security > USB
Security.

Computer will not start.
Cause

Solution

Wrong memory modules were used in the upgrade or memory
modules were installed in the wrong location.

1.

Review the documentation that came with the system to
determine if you are using the correct memory modules and
to verify the proper installation.
NOTE: DIMM1 or XMM1 must always be installed. DIMM1
must be installed before DIMM2, and DIMM3 must be
installed before DIMM4.

2.

Observe the beeps and LED lights on the front of the
computer. Beeps and flashing LEDs are codes for specific
problems.

3.

If you still cannot resolve the issue, contact Customer
Support.

Power LED flashes Red five times, once every second, followed by a two second pause, and the computer beeps five times. (Beeps
stop after fifth iteration but LEDs continue flashing.)
Cause

Solution

Memory is installed incorrectly or is bad.

CAUTION: To avoid damage to the DIMMs or the system board,
you must unplug the computer power cord before attempting to
reseat, install, or remove a DIMM module.
1.

Reseat DIMMs. Power on the system.

2.

Replace DIMMs one at a time to isolate the faulty module.
NOTE: DIMM1 or XMM1 must always be installed. DIMM1
must be installed before DIMM2, and DIMM3 must be
installed before DIMM4
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3.

Replace third-party memory with HP memory.

4.

Replace the system board.

Power LED flashes Red six times, once every second, followed by a two second pause, and the computer beeps six times. (Beeps
stop after fifth iteration but LEDs continue flashing.)
Cause

Solution

Graphics card (some models) is not seated properly or is bad, or
system board is bad.

For systems with a graphics card:
1.

Reseat the graphics card. Power on the system.

2.

Replace the graphics card.

3.

Replace the system board.

For systems with integrated graphics, replace the system board.

Power LED flashes Red ten times, once every second, followed by a two second pause, and the computer beeps ten times. (Beeps
stop after fifth iteration but LEDs continue flashing.)
Cause

Solution

Bad option card.

1.

Check each option card by removing the cards one at time (if
multiple cards), then power on the system to see if fault
goes away.

2.

Once bad card is identified, remove and replace bad option
card.

3.

Replace the system board.

Solving Network Problems
Some common causes and solutions for network problems are listed in the following table. These guidelines
do not discuss the process of debugging the network cabling.
Table 6-2 Solving Network Problems
Wake-on-LAN feature is not functioning.
Cause

Solution

S5 Maximum Power Saving feature is enabled.

Disable the S5 Maximum Power Saving option in Computer Setup.
Select Power > Hardware Power Management > S5 Maximum
Power Savings.

S5 Wake on LAN is disabled (some models).

Enable the S5 Wake on LAN option in Computer Setup. Select
Advanced > Device Options > S5 Wake on LAN.

Wake-on-LAN is not enabled.

To enable Wake-on-LAN in Windows 7:
1.

Select Start > Control Panel > Network and Sharing Center.

2.

Under Tasks, select Manage network connections.

3.

Click Local Area Connection.

4.

Click the Properties button.

5.

Click the Configure button.

6.

Click the Power Management tab, then select Allow this
device to wake the computer.

To enable Wake-on-LAN in Windows 8:
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Table 6-2 Solving Network Problems (continued)
Wake-on-LAN feature is not functioning.
Cause

Solution
1.

From the Start screen, type c, and then select Control Panel
from the list of applications.

2.

Select Network and Sharing Center, and then click the
Ethernet link next to the connection.

3.

Click the Properties button.

4.

Click the Configure button.

5.

Click the Power Management tab, then enable the
appropriate Wake-on LAN option.

Network driver does not detect network controller.
Cause

Solution

Network controller is disabled.

1.

Run Computer Setup and enable network controller.

2.

Enable the network controller in the operating system using
Device Manager.
To access Device Manager in Windows 7, click Start, select
Control Panel, and then select Device Manager.
To access Device Manager in Windows 8, from the Start
screen, type c, select Control Panel from the list of
applications, and then select Device Manager.

Incorrect network driver.

Check the network controller documentation for the correct
driver or obtain the latest driver from the manufacturer’s Web
site.

Network status link light never flashes.
NOTE:

The network status light is supposed to flash when there is network activity.

Cause

Solution

No active network is detected.

Check cabling and network equipment for proper connection.

Network controller is not set up properly.

Check for the device status within Windows, such as Device
Manager for driver load and the Network Connections applet
within Windows for link status.
To access Device Manager in Windows 7, click Start, select
Control Panel, and then select Device Manager.
To access Device Manager in Windows 8, from the Start screen,
type c, select Control Panel from the list of applications, and then
select Device Manager.

Network controller is disabled.
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1.

Run Computer Setup and enable network controller.

2.

Enable the network controller in the operating system using
Device Manager.

Table 6-2 Solving Network Problems (continued)
Network status link light never flashes.
NOTE:

The network status light is supposed to flash when there is network activity.

Cause

Solution
To access Device Manager in Windows 7, click Start, select
Control Panel, and then select Device Manager.
To access Device Manager in Windows 8, from the Start
screen, type c, select Control Panel from the list of
applications, and then select Device Manager.

Network driver is not properly loaded.

Reinstall network drivers.

System cannot autosense the network.

Disable auto-sensing capabilities and force the system into the
correct operating mode.

Diagnostics reports a failure.
Cause

Solution

The cable is not securely connected.

Ensure that the cable is securely attached to the network
connector and that the other end of the cable is securely attached
to the correct device.

The cable is attached to the incorrect connector.

Ensure that the cable is attached to the correct connector.

There is a problem with the cable or a device at the other end of
the cable.

Ensure that the cable and device at the other end are operating
correctly.

Network controller interrupt is shared with an expansion board.

Under the Computer Setup Advanced menu, change the resource
settings for the board.

The network controller is defective.

Contact an authorized service provider.

Diagnostics passes, but the computer does not communicate with the network.
Cause

Solution

Network drivers are not loaded, or driver parameters do not
match current configuration.

Make sure the network drivers are loaded and that the driver
parameters match the configuration of the network controller.
Make sure the correct network client and protocol is installed.

The network controller is not configured for this computer.

Select the Network and Sharing Center icon in the Control Panel
and configure the network controller.
To access Control Panel in Windows 7, click Start, and then select
Control Panel.
To access Control Panel in Windows 8, from the Start screen, type
c, and then select Control Panel.
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Network controller stopped working when an expansion board was added to the computer.
Cause

Solution

Network controller interrupt is shared with an expansion board.

Under the Computer Setup Advanced menu, change the resource
settings for the board.

The network controller requires drivers.

Verify that the drivers were not accidentally deleted when the
drivers for a new expansion board were installed.

The expansion board installed is a network card (NIC) and
conflicts with the embedded NIC.

Under the Computer Setup Advanced menu, change the resource
settings for the board.

Network controller stops working without apparent cause.
Cause

Solution

The files containing the network drivers are corrupted.

Reinstall the network drivers using the Recovery Disc Set in
Windows 7 or Windows recovery tools in Windows 8.
If necessary, download the softpaq from the web (from a
different computer).

The cable is not securely connected.

Ensure that the cable is securely attached to the network
connector and that the other end of the cable is securely attached
to the correct device.

The network controller is defective.

Contact an authorized service provider.

New network card will not boot.
Cause

Solution

New network card may be defective or may not meet industrystandard specifications.

Install a working, industry-standard NIC, or change the boot
sequence to boot from another source.

Cannot connect to network server when attempting Remote System Installation.
Cause

Solution

The network controller is not configured properly.

Verify Network Connectivity, that a DHCP Server is present, and
that the Remote System Installation Server contains the NIC
drivers for your NIC.

System setup utility reports unprogrammed EEPROM.
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Cause

Solution

Unprogrammed EEPROM.

Contact an authorized service provider.
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Solving memory problems
If you encounter memory problems, some common causes and solutions are listed in the following table.
CAUTION: Power may still be supplied to the DIMMs when the computer is turned off (depending on the
Management Engine (ME) settings). To avoid damage to the DIMMs or the system board, you must unplug the
computer power cord before attempting to reseat, install, or remove a memory module.
For those systems that support ECC memory, HP does not support mixing ECC and non-ECC memory.
Otherwise, the computer will not boot the operating system.
NOTE: The memory count will be affected by configurations with the Management Engine (ME) enabled.
The ME uses 8MB of system memory in single channel mode or 16MB of memory in dual-channel mode to
download, decompress, and execute the ME firmware for Out-of-Band (OOB), third-party data storage, and
other management functions.
System will not boot or does not function properly after installing additional memory modules.
Cause

Solution

A memory module is not installed in the DIMM1 or XMM1 socket.

Ensure that a memory module is installed in the DIMM1 or XMM1
socket on the system board. This socket must be populated with
a memory module.

Memory module is not the correct type or speed grade for the
system or the new memory module is not seated properly.

Replace module with the correct industry-standard device for the
computer. On some models, ECC and non-ECC memory modules
cannot be mixed.

Out of memory error.
Cause

Solution

You have run out of memory to run the application.

Check the application documentation to determine the memory
requirements.

Memory count during POST is wrong.
Cause

Solution

The memory modules may not be installed correctly.

Check that the memory modules have been installed correctly
and that proper modules are used.

Integrated graphics may use system memory.

No action required.

Insufficient memory error during operation.
Cause

Solution

Too many Terminate and Stay Resident programs (TSRs) are
installed.

Delete any TSRs that you do not need.

You have run out of memory for the application.

Check the memory requirements for the application or add more
memory to the computer.
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Power LED flashes Red five times, once every second, followed by a two second pause, and the computer beeps five times. (Beeps
stop after fifth iteration but LEDs continue flashing.)
Cause

Solution

Memory is installed incorrectly or is bad.

1.

Reseat DIMMs. Power on the system.

2.

Replace DIMMs one at a time to isolate the faulty module.

3.

Replace third-party memory with HP memory.

4.

Replace the system board.

Solving processor problems
If you encounter processor problems, common causes and solutions are listed in the following table.
Poor performance is experienced.
Cause

Solution

Processor is hot.

1.

Make sure the airflow to the computer is not blocked.

2.

Make sure the fans are connected and working properly
(some fans only operate when needed).

3.

Make sure the processor heat sink is installed properly.

Power LED flashes Red three times, once every second, followed by a two second pause.
Cause

Solution

Processor is not seated properly or not installed.

1.

Check to see that the processor is present.

2.

Reseat the processor.

Power LED flashes Red eleven times, once every second, followed by a two second pause.
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Cause

Solution

The current processor does not support a feature previously
enabled on this system.

▲
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Reinstall the original processor.

Solving CD-ROM and DVD problems
If you encounter CD-ROM or DVD problems, see the common causes and solutions listed in the following
table or to the documentation that came with the optional device.
System will not boot from CD-ROM or DVD drive.
Cause

Solution

The device is attached to a SATA port that has been hidden in the
Computer Setup utility.

Run the Computer Setup utility and ensure Device Available is
selected for the device's SATA port in Security > Device Security.

Removable Media Boot is disabled in the Computer Setup utility.

Run the Computer Setup utility and enable booting to removable
media in Storage > Storage Options. Ensure CD-ROM is enabled
in Storage > Boot Order.

Network Boot is enabled in Computer Setup.

Run the Computer Setup utility and disable Network Boot in
Security > Network Boot.

Non-bootable CD in drive.

Try a bootable CD in the drive.

Boot order not correct.

Run the Computer Setup utility and change boot sequence in
Storage > Boot Order.

Drive not found (identified).
Cause

Solution

Cable could be loose.

Check cable connections.

The system may not have automatically recognized a newly
installed device.

See reconfiguration directions in the Solving Hardware
Installation Problems on page 91 section. If the system still does
not recognize the new device, check to see if the device is listed
within Computer Setup. If it is listed, the probable cause is a
driver problem. If it is not listed, the probable cause is a hardware
problem.
If this is a newly installed drive, run the Computer Setup utility
and try adding a POST delay under Advanced > Power-On
Options.

The device is attached to a SATA port that has been hidden in
Computer Setup.

Run the Computer Setup utility and ensure Device Available is
selected for the device's SATA port in Security > Device Security.

Drive responds slowly immediately after power-up.

Run Computer Setup and increase the POST Delay in Advanced >
Power-On Options.

CD-ROM or DVD devices are not detected or driver is not loaded.
Cause

Solution

Drive is not connected properly or not properly configured.

See the documentation that came with the optional device.

Movie will not play in the DVD drive.
Cause

Solution

Movie may be regionalized for a different country.

See the documentation that came with the DVD drive.

Solving CD-ROM and DVD problems

99

Movie will not play in the DVD drive.
Cause

Solution

Decoder software is not installed.

Install decoder software.

Damaged media.

Replace media.

Movie rating locked out by parental lock.

Use DVD software to remove parental lock.

Media installed upside down.

Reinstall media.

Cannot eject compact disc (tray-load unit).
Cause

Solution

Disc not properly seated in the drive.

Turn off the computer and insert a thin metal rod into the
emergency eject hole and push firmly. Slowly pull the tray out
from the drive until the tray is fully extended, then remove
the disc.

CD-ROM, CD-RW, DVD-ROM, or DVD-R/RW drive cannot read a disc or takes too long to start.
Cause

Solution

Media is corrupt.

Try different media to confirm whether media is valid.

Media has been inserted upside down.

Re-insert the media with the label facing up.

The DVD-ROM drive takes longer to start because it has to
determine the type of media played, such as audio or video.

Wait at least 30 seconds to let the DVD-ROM drive determine the
type of media being played. If the disc still does not start, read
the other solutions listed for this topic.

CD or DVD disc is dirty.

Clean CD or DVD with a CD cleaning kit, available from most
computer stores.

Windows does not detect the CD-ROM or DVD-ROM drive.

1.

Use Device Manager to remove or uninstall the device.
To access Device Manager in Windows 7, click Start, select
Control Panel, and then select Device Manager.
To access Device Manager in Windows 8, from the Start
screen, type c, select Control Panel from the list of
applications, and then select Device Manager.

2.

Restart the computer and let Windows detect the CD or DVD
driver.

Recording or copying CDs is difficult or impossible.
Cause

Solution

Wrong or poor quality media type.

1.

Try using a slower speed when recording.

2.

Verify that you are using the correct media for the drive.

3.

Try a different brand of media. Quality varies widely
between manufacturers.
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Solving USB flash drive problems
If you encounter USB flash drive problems, common causes and solutions are listed in the following table.
USB flash drive is not seen as a drive letter in Windows.
Cause

Solution

The drive letter after the last physical drive is not available.

Change the default drive letter for the flash drive in Windows.

USB flash drive not found (identified).
Cause

Solution

The device is attached to a USB port that has been hidden in
Computer Setup.

Run the Computer Setup utility and enable USB ports in
Security > USB Security.

The device was not properly seated before power-up.

Ensure the device is fully inserted into the USB port before
applying power to the system

System will not boot from USB flash drive.
Cause

Solution

Boot order is not correct.

Run the Computer Setup utility and change boot sequence in
Storage > Boot Order.

Removable Media Boot is disabled in the Computer Setup utility.

Run the Computer Setup utility and enable booting to removable
media in Storage > Storage Options. Ensure USB is enabled in
Storage > Boot Order.

The computer boots to DOS after making a bootable flash drive.
Cause

Solution

Flash drive is bootable.

Install the flash drive only after the operating system boots.

Flash drive is defective.

Try a different flash drive.

Solving front panel component problems
If you encounter problems with devices connected to the front panel, refer to the common causes and
solutions listed in the following table.
A USB device, headphone, or microphone is not recognized by the computer.
Cause

Solution

Device is not properly connected.

1.

Turn off the computer.

2.

Reconnect the device to the front of the computer and
restart the computer.

The device does not have power.

If the USB device requires AC power, be sure one end is connected
to the device and one end is connected to a live outlet.
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A USB device, headphone, or microphone is not recognized by the computer.
Cause

Solution

The correct device driver is not installed.

1.

Install the correct driver for the device.

2.

You might need to reboot the computer.

1.

If possible, replace the cable.

2.

Restart the computer.

1.

Replace the device.

2.

Restart the computer.

The cable from the device to the computer does not work.

The device is not working.

USB ports on the computer are disabled in Computer Setup.

Run the Computer Setup utility and ensure that the USB ports are
set to Enabled in Security > USB Security.

Solving Internet access problems
If you encounter Internet access problems, consult your Internet Service Provider (ISP) or refer to the
common causes and solutions listed in the following table.
Unable to connect to the Internet.
Cause

Solution

Internet Service Provider (ISP) account is not set up properly.

Verify Internet settings or contact your ISP for assistance.

Web browser is not set up properly.

Verify that the Web browser is installed and set up to work with
your ISP.

Cable/DSL modem is not plugged in.

Plug in cable/DSL modem. You should see a “power” LED light on
the front of the cable/DSL modem.

Cable/DSL service is not available or has been interrupted due to
bad weather.

Try connecting to the Internet at a later time or contact your ISP.
(If the cable/DSL service is connected, the “cable” LED light on the
front of the cable/DSL modem will be on.)

The CAT5 UTP cable is disconnected.

Connect the CAT5 UTP cable between the cable modem and the
computers’s RJ-45 connector. (If the connection is good, the “PC”
LED light on the front of the cable/DSL modem will be on.)

IP address is not configured properly.

Contact your ISP for the correct IP address.

Cookies are corrupted. (A “cookie” is a small piece of information
that a Web server can store temporarily with the Web browser.
This is useful for having the browser remember some specific
information that the Web server can later retrieve.)

Windows 7:
1.

Select Start > Control Panel.

2.

Click Internet Options.

3.

In the Browsing history section on the General tab, click the
Delete button.

4.

Select the Cookies check box and click the Delete button.

Windows 8:
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1.

From the Start screen, type c, and then select Control Panel
from the list of applications..

2.

Click Internet Options.

3.

In the Browsing history section on the General tab, click the
Delete button.

Unable to connect to the Internet.
Cause

Solution
4.

Select the Cookies check box and click the Delete button.

Cannot automatically launch Internet programs.
Cause

Solution

You must log on to your ISP before some programs will start.

Log on to your ISP and launch the desired program.

Solving software problems
Most software problems occur as a result of the following:
●

The application was not installed or configured correctly.

●

There is insufficient memory available to run the application.

●

There is a conflict between applications.

●

Be sure that all the needed device drivers have been installed.

●

If you have installed an operating system other than the factory-installed operating system, check to be
sure it is supported on the system.

If you encounter software problems, see the applicable solutions listed in the following table.
Computer will not continue and the HP logo does not display.
Cause

Solution

ROM issue - POST error has occurred.

Observe the beeps and LED lights on the front of the computer.
See Appendix A, POST error messages on page 105 to determine
possible causes.
See the Worldwide Limited Warranty for terms and conditions.

Computer will not continue after HP logo screen displays.
Cause

Solution

System files may be damaged.

In Windows 7, use recovery media to scan hard drive for errors, or
use Windows Startup Repair to fix problems that might prevent
Windows from starting correctly. Windows Startup Repair is one
of the recovery tools in the System Recovery Options menu. You
can also create a system repair disc that contains the System
Recovery Options menu. If the problem is severe enough that
Startup Repair doesn't start on its own and you can't access the
System Recovery Options menu on your computer's hard disk,
you can get to the menu and start Startup Repair by using the
Windows installation disc or a system repair disc that you created
earlier.
In Windows 8, use Automatic Repair to fix problems that might
prevent Windows from starting correctly.
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Computer will not continue after HP logo screen displays.
Cause

Solution
To access Automatic Repair:
1.

Press the Windows logo + l to open the Settings charm.

2.

Select Change PC Settings, select General, and then under
Advanced startup, click Restart now.

3.

Select Troubleshoot, select Advanced options, and then
select Automatic Repair.
Windows starts Automatic Repair.

4.

Select the account to use to begin Automatic Repair, and
type the password for the account.
Windows diagnoses the computer and attempts the repair
it.

“Illegal Operation has Occurred” error message is displayed.
Cause

Solution

Software being used is not Microsoft-certified for your version of
Windows.

Verify that the software is certified by Microsoft for your version
of Windows (see program packaging for this information).

Configuration files are corrupt.

If possible, save all data, close all programs, and restart the
computer.
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7

POST error messages
This appendix lists the error codes, error messages, and the various indicator light and audible sequences
that you may encounter during Power-On Self-Test (POST) or computer restart, the probable source of the
problem, and steps you can take to resolve the error condition.
POST Message Disabled suppresses most system messages during POST, such as memory count and nonerror text messages. If a POST error occurs, the screen will display the error message. To manually switch to
the POST Messages Enabled mode during POST, press any key (except F10, F11, or F12). The default mode is
POST Message Disabled.
The speed at which the computer loads the operating system and the extent to which it is tested are
determined by the POST mode selection.
Quick Boot is a fast startup process that does not run all of the system level tests, such as the memory test.
Full Boot runs all of the ROM-based system tests and takes longer to complete.
Full Boot may also be enabled to run every 1 to 30 days on a regularly scheduled basis. To establish the
schedule, reconfigure the computer to the Full Boot Every x Days mode, using Computer Setup.
NOTE: For more information on Computer Setup, see Computer Setup (F10) Utility on page 61.

POST numeric codes and text messages
This section covers those POST errors that have numeric codes associated with them. The section also
includes some text messages that may be encountered during POST.
NOTE: The computer will beep once after a POST text message is displayed on the screen.
Control panel message

Description

Recommended action

101-Option ROM Checksum Error

System ROM or expansion board option ROM
checksum.

1.

Verify the correct ROM.

2.

Flash the ROM if needed.

3.

If an expansion board was recently added,
remove it to see if the problem remains.

4.

Clear CMOS. (See Appendix B, Password
security and resetting CMOS
on page 115.)

5.

If the message disappears, there may be a
problem with the expansion card.

6.

Replace the system board.

1.

Clear CMOS. (See Appendix B, Password
security and resetting CMOS
on page 115.)

2.

Remove expansion boards.

3.

Replace the system board.

1.

If a PCI expansion card was recently
added, remove it to see if the problem
remains.

103-System Board Failure

110-Out of Memory Space for Option ROMs

DMA or timers.

Recently added PCI expansion card contains an
option ROM too large to download during POST.
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Control panel message

Description

Recommended action
2.

162-System Options Not Set

Configuration incorrect.
RTC (real-time clock) battery may need to
be replaced.

163-Time & Date Not Set

Invalid time or date in configuration memory.
RTC (real-time clock) battery may need to
be replaced.

In Computer Setup, set Advanced >
Device Options > NIC PXE Option ROM
Download to DISABLE to prevent PXE
option ROM for the internal NIC from
being downloaded during POST to free
more memory for an expansion card's
option ROM. Internal PXE option ROM is
used for booting from the NIC to a PXE
server.

Run Computer Setup and check the
configuration in Advanced > Onboard Devices.
Reset the date and time under Control Panel. If
the problem persists, replace the RTC battery.
See the Removal and Replacement section for
instructions on installing a new battery, or
contact an authorized dealer or reseller for RTC
battery replacement.
Reset the date and time under Control Panel
(Computer Setup can also be used). If the
problem persists, replace the RTC battery. See
the Removal and Replacement section for
instructions on installing a new battery, or
contact an authorized dealer or reseller for RTC
battery replacement.

163-Time & Date Not Set

CMOS jumper may not be properly installed.

Check for proper placement of the CMOS
jumper if applicable.

164-MemorySize Error

Memory amount has changed since the last
boot (memory added or removed).

Press the F1 key to save the memory changes.

164-MemorySize Error

Memory configuration incorrect.

1.

Run Computer Setup or Windows utilities.

2.

Make sure the memory module(s) are
installed properly.

3.

If third-party memory has been added,
test using HP-only memory.

4.

Verify proper memory module type.

1.

Ensure memory modules are correctly
installed.

2.

Verify proper memory module type.

3.

Remove and replace the identified faulty
memory module(s).

4.

If the error persists after replacing
memory modules, replace the system
board.

A memory module in memory socket identified
in the error message is missing critical SPD
information, or is incompatible with the
chipset.

1.

Verify proper memory module type.

2.

Try another memory socket.

3.

Replace DIMM with a module conforming
to the SPD standard.

Populated DIMM Configuration is not optimized.

Rearrange the DIMMs so that each channel has
the same amount of memory.

201-Memory Error

213-Incompatible Memory Module in Memory
Socket(s) X, X, ...

214-DIMM Configuration Warning
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RAM failure.

Control panel message

Description

Recommended action

219-ECC Memory Module Detected ECC
Modules not supported on this Platform

Recently added memory module(s) support ECC
memory error correction.

1.

If additional memory was recently added,
remove it to see if the problem remains.

2.

Check product documentation for
memory support information.

1.

Reconnect keyboard with computer
turned off.

2.

Check connector for bent or missing pins.

3.

Ensure that none of the keys are
depressed.

4.

Replace keyboard.

1.

Reconnect keyboard with computer
turned off.

2.

Replace the system board.

1.

Reconnect the keyboard with computer
turned off.

2.

Ensure that none of the keys are
depressed.

3.

Replace the keyboard.

4.

Replace the system board.

1.

Reseat the graphics card (if applicable).

2.

Clear CMOS. (See Appendix B, Password
security and resetting CMOS
on page 115.)

3.

Verify monitor is attached and turned on.

4.

Replace the graphics card (if possible).

301-Keyboard Error

303-Keyboard Controller Error

304-Keyboard or System Unit Error

501-Display Adapter Failure

Keyboard failure.

I/O board keyboard controller.

Keyboard failure.

Graphics display controller.

510-Flash Screen Image Corrupted

Flash Screen image has errors.

Reflash the system ROM with the latest BIOS
image.

511-CPU, CPUA, or CPUB Fan not Detected

CPU fan is not connected or may have
malfunctioned.

1.

Reseat CPU fan.

2.

Reseat fan cable.

3.

Replace CPU fan.

1.

Reseat chassis, rear chassis, or front
chassis fan.

2.

Reseat fan cable.

3.

Replace chassis, rear chassis, or front
chassis fan.

1.

Reseat front chassis fan.

2.

Reseat fan cable.

3.

Replace front chassis fan.

1.

Reseat CPU or chassis fan.

2.

Reseat fan cable.

3.

Replace CPU or chassis fan.

512-Chassis, Rear Chassis, or Front Chassis Fan
not Detected

513-Front Chassis fan not detected

514-CPU or Chassis Fan not Detected

Chassis, rear chassis, or front chassis fan is not
connected or may have malfunctioned.

Front chassis fan is not connected or may have
malfunctioned.

CPU or chassis fan is not connected or may
have malfunctioned.
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Control panel message

Description

Recommended action

515-Power Supply fan not detected

Power supply fan is not connected or may have
malfunctioned.

1.

Reseat power supply fan.

2.

Reseat fan cable.

3.

Replace power supply fan.

1.

Check and/or replace cables.

2.

Clear CMOS. (See Appendix B, Password
security and resetting CMOS
on page 115.)

3.

Replace diskette drive.

4.

Replace the system board.

1.

Disconnect any other diskette controller
devices (tape drives).

2.

Clear CMOS. (See Appendix B, Password
security and resetting CMOS
on page 115.)

601-Diskette Controller Error

605-Diskette Drive Type Error

Diskette controller circuitry or floppy drive
circuitry incorrect.

Mismatch in drive type.

660-Display cache is detected unreliable

Integrated graphics controller display cache is
not working properly and will be disabled.

Replace system board if minimal graphics
degrading is an issue.

912-Computer Cover Has Been Removed Since
Last System Startup

Computer cover was removed since last system
startup.

No action required.

917-Front Audio Not Connected

Front audio harness has been detached or
unseated from motherboard.

Reconnect or replace front audio harness.

918-Front USB Not Connected

Front USB harness has been detached or
unseated from motherboard.

Reconnect or replace front USB harness.

921-Device in PCI Express slot failed to
initialize

There is an incompatibility/problem with this
device and the system or PCI Express Link could
not be retrained to an x1.

Try rebooting the system. If the error reoccurs,
the device may not work with this system

1151-Serial Port A Address Conflict Detected

Both external and internal serial ports are
assigned to COM1.

1.

Remove any serial port expansion cards.

2.

Clear CMOS. (See Appendix B, Password
security and resetting CMOS
on page 115.)

3.

Reconfigure card resources and/or run
Computer Setup or Windows utilities.

1.

Remove any serial port expansion cards.

2.

Clear CMOS. (See Appendix B, Password
security and resetting CMOS
on page 115.)

3.

Reconfigure card resources and/or run
Computer Setup or Windows utilities.

1.

Remove any serial port expansion cards.

2.

Clear CMOS. (See Appendix B, Password
security and resetting CMOS
on page 115.)

3.

Reconfigure card resources and/or run
Computer Setup or Windows utilities.

1152-Serial Port B Address Conflict Detected

1155-Serial Port Address Conflict Detected
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Both external and internal serial ports are
assigned to COM2.

Both external and internal serial ports are
assigned to same IRQ.

Control panel message

Description

Recommended action

1720-SMART Hard Drive Detects Imminent
Failure

Hard drive is about to fail. (Some hard drives
have a hard drive firmware patch that will fix an
erroneous error message.)

1.

Determine if hard drive is giving correct
error message. Run the Drive Protection
System test under using F2 Diagnostics
when booting the computer.

2.

Apply hard drive firmware patch
if applicable. (Available at
http://www.hp.com/support.)

3.

Back up contents and replace hard drive.

1796-SATA Cabling Error

One or more SATA devices are improperly
attached. For optimal performance, the SATA 0
and SATA 1 connectors must be used before
SATA 2 and SATA 3.

Ensure SATA connectors are used in ascending
order. For one device, use SATA 0. For two
devices, use SATA 0 and SATA 1. For three
devices, use SATA 0, SATA 1, and SATA 2.

1797-SATA Drivelock is not supported in RAID
mode.

Drivelock is enabled on one or more SATA hard
drives, and they cannot be accessed while the
system is configured for RAID mode.

Either remove the Drivelocked SATA device or
disable the Drivelock feature. To disable the
Drivelock feature, enter Computer Setup,
change Storage > Storage Options > SATA
Emulation to IDE, and select File > Save
Changes and Exit. Reenter Computer Setup and
select Security > Drivelock Security. For each
listed Drivelock-capable SATA device, ensure
Drivelock is Disabled. Lastly, change Storage >
Storage Options > SATA Emulation back to
RAID and select File > Save Changes and Exit.

1801-Microcode Patch Error

Processor is not supported by ROM BIOS.

1.

Upgrade BIOS to proper version.

2.

Change the processor.

1.

Reboot the computer.

2.

Unplug the power cord, re-seat the
memory modules, and reboot the
computer.

3.

If the memory configuration was recently
changed, unplug the computer, restore
the original memory configuration, and
reboot the computer.

4.

If the error persists, replace the system
board.

1.

Reboot the computer.

2.

Unplug the power cord, re-seat the
memory modules, and reboot the
computer.

3.

If the memory configuration was recently
changed, unplug the power cord, restore
the original memory configuration, and
reboot the computer.

4.

If the error persists, replace the system
board.

1.

Reboot the computer.

2.

Unplug the power cord, re-seat the
memory modules, and reboot the
computer.

2200-PMM Allocation Error during MEBx
Download

2201-MEBx Module did not checksum correctly

2202-PMM Deallocation Error during MEBx
cleanup

Memory error during POST execution of the
Management Engine (ME) BIOS Extensions
option ROM.

Memory error during POST execution of the
Management Engine (ME) BIOS Extensions
option ROM.

Memory error during POST execution of the
Management Engine (ME) BIOS Extensions
option ROM.
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Control panel message

2203-Setup error during MEBx execution

2204-Inventory error during MEBx execution

2205-Interface error during MEBx execution

Description

MEBx selection or exit resulted in a setup
failure.

BIOS information passed to the MEBx resulted
in a failure.

MEBx operation experienced a hardware error
during communication with ME.

Recommended action
3.

If the memory configuration was recently
changed, unplug the power cord, restore
the original memory configuration, and
reboot the computer.

4.

If the error persists, replace the system
board.

1.

Reboot the computer.

2.

Unplug the power cord, re-seat the
memory modules, and reboot the
computer.

3.

If the memory configuration was recently
changed, unplug the power cord, restore
the original memory configuration, and
reboot the computer.

4.

If the error persists, replace the system
board.

1.

Reboot the computer.

2.

If the error persists, update to the latest
BIOS version.

3.

If the error still persists, replace the
system board.

1.

Reboot the computer.

2.

If the error persists, update to the latest
BIOS version.

3.

If the error still persists, replace the
system board.

2211-Memory not configured correctly for
proper MEBx execution.

DIMM1 or XMM1 is not installed.

Make sure there is a memory module in the
black DIMM1 socket and that it is properly
seated.

2212-USB Key Provisioning failure writing to
device

USB device used for USB key provisioning will
not allow BIOS to update provision file
properly.

1.

Try a different USB key device for
provisioning.

2.

If the error persists, update to the latest
BIOS version and ME firmware version.

3.

If the error still persists, replace the
system board.

1.

Reboot the computer.

2.

If the error persists, update to the latest
BIOS version and ME firmware version.

3.

If the error still persists, replace the
system board.

1.

Update to the latest ME firmware version.

2.

If the error persists and system BIOS has
been recently updated, restore previous
system BIOS version.

3.

If the error still persists, replace the
system board.

2217-ME Firmware Version request failure

2218-ME Firmware Version should be updated
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ME firmware is not properly responding to BIOS
query for version information.

ME firmware must be updated to match current
functionality contained in the system BIOS.

Control panel message

Description

Recommended action

2219-USB Key Provisioning file has invalid
header identifier

Provisioning file contained on the USB key has
been corrupted or is not a valid version for the
current ME firmware.

1.

Recreate the provisioning file using third
party management console software.

2.

If the error persists and system BIOS has
been recently updated, restore previous
system BIOS version. Otherwise, update
the ME firmware version.

3.

If the error still persists, replace the
system board.

1.

Reboot the computer.

2.

If the error persists and system BIOS has
been recently updated, restore previous
system BIOS version. Otherwise, update
the ME firmware version.

3.

If the error still persists, replace the
system board.

Error occurred during MEBx execution which
fails into the “General” grouping. Status
information displayed along with the error
provides further clarity into the failure. MEBx
handles transference of information between
the system BIOS and ME firmware.

1.

Reboot the computer.

2.

If the error persists, update to the latest
BIOS version and ME firmware version.

3.

If the error still persists, replace the
system board.

Error occurred during MEBx execution which
fails into “ME” grouping.

1.

Reboot the computer.

2.

If the error persists, update to the latest
BIOS version and ME firmware version.

3.

If the error still persists, replace the
system board.

1.

Reboot the computer.

2.

If the error persists, update to the latest
BIOS version and ME firmware version.

3.

If the error still persists, replace the
system board.

1.

Reboot the computer.

2.

If the error persists, update to the latest
BIOS version and ME firmware version.

3.

If the error still persists, replace the
system board.

Special system configurations with reduced ME
firmware image require BIOS control of ME
firmware upgrading. A failure has occurred
after the ME firmware update process in which
the BIOS could not relock the ME firmware
region.

1.

Reboot the computer.

2.

If the error persists, update to the latest
BIOS version and ME firmware version.

3.

If the error still persists, replace the
system board.

Special system configurations with reduced ME
firmware image require BIOS control of ME
firmware upgrading. A failure has occurred
prior to the ME firmware update process in
which the BIOS could not unlock the ME
firmware region.

1.

Reboot the computer.

2.

If the error persists, update to the latest
BIOS version and ME firmware version.

3.

If the error still persists, replace the
system board.

2220-USB Key Provisioning file has mismatch
version

2230-General error during MEBx execution

2231-ME error during MEBx execution

2232-AMT error during MEBx execution

2233-HECI error during MEBx execution

2239-ME image lock failure

2240-ME image unlock failure

Provisioning file contained on the USB key is
not a valid version for the current ME firmware.

Error occurred during MEBx execution which
fails into “AMT” grouping.

Error occurred during MEBx execution which
fails into “MEI or HECI” grouping.
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Control panel message

Description

Recommended action

Invalid Electronic Serial Number

Electronic serial number is missing.

Enter the correct serial number in Computer
Setup.

Network Server Mode Active and No Keyboard
Attached

Keyboard failure while Network Server Mode
enabled.

1.

Reconnect keyboard with computer
turned off.

2.

Check connector for bent or missing pins.

3.

Ensure that none of the keys are
depressed.

4.

Replace keyboard.

Parity Check 2

Parity RAM failure.

Run Computer Setup and Diagnostic utilities.

Interpreting POST diagnostic front panel LEDs and audible codes
This section covers the front panel LED codes as well as the audible codes that may occur before or during
POST that do not necessarily have an error code or text message associated with them.
WARNING! When the computer is plugged into an AC power source, voltage is always applied to the system
board. To reduce the risk of personal injury from electrical shock and/or hot surfaces, be sure to disconnect
the power cord from the wall outlet and allow the internal system components to cool before touching.
NOTE: If you see flashing LEDs on a PS/2 keyboard, look for flashing LEDs on the front panel of the
computer and refer to the following table to determine the front panel LED codes.
Recommended actions in the following table are listed in the order in which they should be performed.
Not all diagnostic lights and audible codes are available on all models.
Activity

Beeps

Possible cause

Recommended action

White Power LED On.

None

Computer on.

None

White Power LED flashes every
two seconds.

None

Computer in Suspend to
RAM mode (some models
only) or normal Suspend
mode.

None required. Press any key or move the mouse to
wake the computer.

Red Power LED flashes two
times, once every second,
followed by a two second pause.
Beeps stop after fifth iteration
but LEDs continue until problem
is solved.

2

Processor thermal
protection activated:

1.

Ensure that the computer air vents are not
blocked and the processor cooling fan is
running.

2.

Open hood, press power button, and see if the
processor fan spins. If the processor fan is not
spinning, make sure the fan's cable is plugged
onto the system board header.

3.

If fan is plugged in, but is not spinning, then
replace heat sink/fan assembly.

4.

Contact an authorized reseller or service
provider.

1.

Check to see that the processor is present.

2.

Reseat the processor.

A fan may be blocked or not
turning.
OR
The heat sink/fan assembly
is not properly attached to
the processor.

Red Power LED flashes three
times, once every second,
followed by a two second pause.
Beeps stop after fifth iteration
but LEDs continue until problem
is solved.
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3

Processor not installed (not
an indicator of bad
processor).

Activity

Beeps

Possible cause

Recommended action

Red Power LED flashes four
times, once every second,
followed by a two second pause.
Beeps stop after fifth iteration
but LEDs continue until problem
is solved.

4

Power failure (power supply
is overloaded).

1.

Open the hood and ensure the 4 or 6-wire
power supply cable is seated into the
connector on the system board.

2.

Check if a device is causing the problem by
removing ALL attached devices (such as hard,
diskette, or optical drives, and expansion
cards). Power on the system. If the system
enters the POST, then power off and replace
one device at a time and repeat this procedure
until failure occurs. Replace the device that is
causing the failure. Continue adding devices
one at a time to ensure all devices are
functioning properly.

3.

Replace the power supply.

4.

Replace the system board.

Red Power LED flashes five
times, once every second,
followed by a two second pause.
Beeps stop after fifth iteration
but LEDs continue until problem
is solved.

Red Power LED flashes six times,
once every second, followed by
a two second pause. Beeps stop
after fifth iteration but LEDs
continue until problem is solved.

5

6

Pre-video memory error.

Pre-video graphics error.

CAUTION: To avoid damage to the DIMMs or the
system board, you must unplug the computer power
cord before attempting to reseat, install, or remove
a DIMM module.
1.

Reseat DIMMs.

2.

Replace DIMMs one at a time to isolate the
faulty module.

3.

Replace third-party memory with HP memory.

4.

Replace the system board.

For systems with a graphics card:
1.

Reseat the graphics card.

2.

Replace the graphics card.

3.

Replace the system board.

For systems with integrated graphics, replace the
system board.
Red Power LED flashes seven
times, once every second,
followed by a two second pause.
Beeps stop after fifth iteration
but LEDs continue until problem
is solved.

7

System board failure (ROM
detected failure prior to
video).

Replace the system board.

Red Power LED flashes eight
times, once every second,
followed by a two second pause.
Beeps stop after fifth iteration
but LEDs continue until problem
is solved.

8

Invalid ROM based on bad
checksum.

1.

Reflash the system ROM with the latest BIOS
image.

2.

Replace the system board.

Red Power LED flashes nine
times, once every second,
followed by a two second pause.
Beeps stop after fifth iteration
but LEDs continue until problem
is solved.

9

1.

Check that the voltage selector, located on the
rear of the power supply (some models), is set
to the appropriate voltage. Proper voltage
setting depends on your region.

2.

Unplug the AC power cord from the computer,
wait 30 seconds, then plug the power cord
back in to the computer.

System powers on but is
unable to boot.
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Activity

Red Power LED flashes ten
times, once every second,
followed by a two second pause.
Beeps stop after fifth iteration
but LEDs continue until problem
is solved.

Beeps

10

Possible cause

Bad option card.

Recommended action
3.

Replace the system board.

4.

Replace the processor.

1.

Check each option card by removing the card
(one at a time if multiple cards), then power on
the system to see if fault goes away.

2.

Once a bad card is identified, remove and
replace the bad option card.

3.

Replace the system board.
Reinstall the original processor.

Red Power LED flashes eleven
times, once every second,
followed by a two second pause.
Beeps stop after fifth iteration
but LEDs continue until problem
is solved.

11

The current processor does
not support a feature
previously enabled on this
system.

▲

System does not power on and
LEDs are not flashing.

None

System unable to power on.

Press and hold the power button for less than 4
seconds. If the hard drive LED turns white, the power
button is working correctly. Try the following:
1.

Check that the voltage selector (some models),
located on the rear of the power supply, is set
to the appropriate voltage. Proper voltage
setting depends on your region.

2.

Replace the system board.

OR
Press and hold the power button for less than 4
seconds. If the hard drive LED does not turn on white
then:
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1.

Check that the unit is plugged into a working
AC outlet.

2.

Open hood and check that the power button
harness is properly connected to the system
board.

3.

Check that both power supply cables are
properly connected to the system board.

4.

Check to see if the 5V_aux light on the system
board is turned on. If it is turned on, then
replace the power button harness. If the
problem persists, replace the system board.

5.

If the 5V_aux light on the system board is not
turned on, remove the expansion cards one at
a time until the 5V_aux light on the system
board turns on. It the problem persists, replace
the power supply.

8

Password security and resetting CMOS
This computer supports security password features, which can be established through the Computer Setup
Utilities menu.
This computer supports two security password features that are established through the Computer Setup
Utilities menu: setup password and power-on password. When you establish only a setup password, any user
can access all the information on the computer except Computer Setup. When you establish only a power-on
password, the power-on password is required to access Computer Setup and any other information on the
computer. When you establish both passwords, only the setup password will give you access to Computer
Setup.
When both passwords are set, the setup password can also be used in place of the power-on password as an
override to log in to the computer. This is a useful feature for a network administrator.
If you forget the password for the computer, you can clear that password so you can gain access to the
information on the computer by resetting the password jumper.
CAUTION: Pushing the CMOS button will reset CMOS values to factory defaults. It is important to back up
the computer CMOS settings before resetting them in case they are needed later. Back up is easily done
through Computer Setup. See Computer Setup (F10) Utility on page 61 for information on backing up the
CMOS settings.

Resetting the password jumper
CAUTION: If you enable the stringent security feature in Computer Setup and you forget the setup
password or the power-on password, the computer is inaccessible and can no longer be used.
Enabling the stringent password disables the ability to reset the password by moving the jumper on the
system board.
If you lose or forget the password, the system board must be replaced. This scenario is not covered under
warranty.
To prevent the computer from becoming permanently unusable, record your configured setup password or
power-on password in a safe place away from your computer. Without these passwords, the computer
cannot be unlocked.
To disable the power-on or setup password features, or to clear the power-on or setup passwords, complete
the following steps:
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1.

Shut down the operating system properly, then turn off the computer and any external devices, and
disconnect the power cord from the power outlet.

2.

With the power cord disconnected, press the power button again to drain the system of any residual
power.
WARNING! To reduce the risk of personal injury from electrical shock and/or hot surfaces, be sure to
disconnect the power cord from the wall outlet, and allow the internal system components to cool
before touching.
CAUTION: When the computer is plugged in, the power supply always has voltage applied to the
system board even when the unit is turned off. Failure to disconnect the power cord can result in
damage to the system.
Static electricity can damage the electronic components of the computer or optional equipment. Before
beginning these procedures, ensure that you are discharged of static electricity by briefly touching a
grounded metal object. See the Safety & Regulatory Information guide for more information.

3.

Remove the access panel.

4.

Locate the header and jumper.
NOTE: The password jumper is green so that it can be easily identified. For assistance locating the
password jumper and other system board components, see the Illustrated Parts & Service Map (IPSM).
The IPSM can be downloaded from http://www.hp.com/support.

5.

Remove the jumper from pins 1 and 2. Place the jumper on either pin 1 or 2, but not both, so that it does
not get lost.

6.

Replace the computer cover or access panel.

7.

Reconnect the external equipment.

8.

Plug in the computer and turn on power. Allow the operating system to start. This clears the current
passwords and disables the password features.

9.

To establish new passwords, repeat steps 1 through 4, replace the password jumper on pins 1 and 2,
then repeat steps 6 through 8. Establish the new passwords in Computer Setup.

Clearing and resetting the CMOS
The computer’s configuration memory (CMOS) stores information about the computer’s configuration.
The CMOS button resets CMOS but does not clear the power-on and setup passwords.
Clearing CMOS will clear the Active Management Technology (AMT) settings in the Management Engine BIOS
Extension (MEBx), including the password. The password will default to “admin” and will need to be reset.
The AMT settings will also need to be reset. To access the MEBx, press Ctrl+P during POST.
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1.

Turn off the computer and any external devices, and disconnect the power cord from the power outlet.

2.

Disconnect the keyboard, monitor, and any other external equipment connected to the computer.
WARNING! To reduce the risk of personal injury from electrical shock and/or hot surfaces, be sure to
disconnect the power cord from the wall outlet, and allow the internal system components to cool
before touching.
CAUTION: When the computer is plugged in, the power supply always has voltage applied to the
system board even when the unit is turned off. Failure to disconnect the power cord can result in
damage to the system.
Static electricity can damage the electronic components of the computer or optional equipment. Before
beginning these procedures, ensure that you are discharged of static electricity by briefly touching a
grounded metal object. See the Safety & Regulatory Information guide for more information.

3.

Remove the computer cover or access panel.
CAUTION: Pushing the CMOS button will reset CMOS values to factory defaults. It is important to back
up the computer CMOS settings before resetting them in case they are needed later. Back up is easily
done through Computer Setup. See Computer Setup (F10) Utility on page 61 for information on backing
up the CMOS settings.

4.

Locate, press, and hold the CMOS button in for five seconds.
NOTE: Make sure you have disconnected the AC power cord from the wall outlet. The CMOS button will
not clear CMOS if the power cord is connected.

NOTE: For assistance locating the CMOS button and other system board components, see the
Illustrated Parts & Service Map (IPSM).
5.

Replace the computer cover or access panel.

6.

Reconnect the external devices.

7.

Plug in the computer and turn on power.
NOTE: You will receive POST error messages after clearing CMOS and rebooting advising you that
configuration changes have occurred. Use Computer Setup to reset any special system setups along
with the date and time.

For instructions on Computer Setup, see Computer Setup (F10) Utility on page 61.

Clearing and resetting the CMOS 117

9

HP PC Hardware Diagnostics
To help troubleshoot and diagnose failures, use the UEFI-based hardware diagnostic solution that HP
includes on all products. This tool can even be used if the computer will not boot to the operating system.

Why run HP PC Hardware Diagnostics
The HP PC Hardware Diagnostic tools simplify the process of diagnosing hardware issues and expedite the
support process when issues are found. The tools save time by pinpointing the component that needs to be
replaced.
●

Isolate true hardware failures: The diagnostics run outside of the operating system so they effectively
isolate hardware failures from issues that may be caused by the operating system or other software
components.

●

Failure ID: When a failure is detected that requires hardware replacement, a 24-digit Failure ID is
generated. This ID can then be provided to the call agent, who will either schedule support or provide
replacement parts.

How to access and run HP PC Hardware Diagnostics
You can run the diagnostics from one of three places, depending on your preference and the health of the
computer.
1.

Turn on the computer and press Esc repeatedly until the BIOS Boot Menu appears.

2.

Press F2 or select Diagnostics (F2).
Pressing F2 signals the system to search for the diagnostics in the following locations:
a.

A connected USB drive (to download the diagnostics tools to a USB drive, see the instructions in
Downloading HP PC Hardware Diagnostics (UEFI) to a USB device on page 118)

b.

The hard disk drive

c.

A core set of diagnostics in the BIOS (for memory and hard disk drive) that are accessible only if
the USB or hard disk drive versions are not detected

Downloading HP PC Hardware Diagnostics (UEFI) to a USB device
NOTE: Instructions for downloading HP PC Hardware Diagnostics (UEFI) are provided in English only.
There are two options to download HP PC Hardward Diagnostics to USB device.
Option 1: HP PC Diagnostics homepage–Provides access to the latest UEFI version
1.

Go to http://www.hp.com/go/techcenter/pcdiags.

2.

Click the UEFI Dowload link, and then select Run.

Option 2: Support and Drivers pages–Provides downloads for a specific product for earlier and later
versions.
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1.

Go to http://www.hp.com.

2.

Point to Support, located at the top of the page, and then click Download Drivers.

3.

In the text box, enter the product name, and then click Go.
– or –
Click Find Now to let HP automatically detect your product.

4.

Select your computer model, and then select your operating system.

5.

In the Diagnostic section, click HP UEFI Support Environment.

6.

Click Download, and then select Run.
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10 System backup and recovery
Backing up, restoring, and recovering in Windows 8.1 or
Windows 8
Your computer includes tools provided by HP and Windows to help you safeguard your information
and retrieve it if you ever need to. These tools will help you return your computer to a proper working state
or even back to the original factory state, all with simple steps.
This section provides information about the following processes:
●

Creating recovery media and backups

●

Restoring and recovering your system

NOTE: This section describes an overview of backing up, restoring, and recovering options. For more details
about the tools provided, see Help and Support. From the Start screen, type help, and then select Help and
Support.

Creating recovery media and backups
Recovery after a system failure is only as good as your most recent backup.
1.

After you successfully set up the computer, create recovery media. This step creates a backup of the
recovery partition on the computer. The backup can be used to reinstall the original operating system in
cases where the hard drive is corrupted or has been replaced.
You will use a USB flash drive to create a bootable recovery drive that can be used to troubleshoot a
computer that is unable to start. The USB flash drive can be used to reinstall the original operating
system and the programs that were installed at the factory.
NOTE:

2.

Any information on the USB flash drive will be erased before the recovery media is created.

●

To create the Windows 8.1 recovery media, from the Start screen, type recovery drive, then
click on Create a recovery drive. Follow the on-screen instructions to continue.

●

To create the Windows 8 recovery media, from the Start screen, type recovery drive, and
then click on Settings, then click on Create a recovery drive. Follow the on-screen instructions to
continue.

Use the Windows tools to create system restore points and create backups of personal information. For
more information and steps, see Help and Support. From the Start screen, type help, and then select
Help and Support.

Restoring and recovering using Windows tools
Windows offers several options for restoring from backup, refreshing the computer, and resetting the
computer to its original state. For more information and steps, see Help and Support. From the Start screen,
type help, and then select Help and Support.
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Using Reset when the system is not responding
NOTE: You may be prompted by User Account Control for your permission or password when you perform
certain tasks. To continue a task, select the appropriate option. For information about User Account Control,
see Help and Support. From the Start screen, type help, and then select Help and Support.
IMPORTANT: Reset does not provide backups of your information. Before using Reset, back up any
personal information you wish to retain.
If Windows recovery steps are not working and the system is not responding, use these steps to start Reset:
1.

If possible, back up all personal files.

2.

If possible, check for the presence of the HP Recovery partition:
●

For Windows 8.1, from the Start screen, type pc, and then select This PC.

●

For Windows 8, from the Start screen, type c, and then select Computer.

NOTE: If the HP Recovery partition is not listed, or you cannot check for its presence, you must recover
using the recovery media you created; see Recovery using the Windows recovery USB flash drive
on page 121. Or you must use the Windows operating system media and the Driver Recovery media
(purchased separately); see Recovery using Windows operating system media (purchased separately)
on page 122.
3.

If the HP Recovery partition is listed, restart the computer, and then press esc while the HP logo is
displayed. The computer Startup Menu displays.

4.

Press f11 to select the System Recovery option.

5.

Choose your keyboard layout.

6.

Select Troubleshoot.

7.

Select Reset.

8.

Follow the on-screen instructions to continue.

Recovery using the Windows recovery USB flash drive
To recover your system using the recovery USB flash drive you previously created:
NOTE: If you did not create a recovery USB flash drive or the one you created does not work, see Recovery
using Windows operating system media (purchased separately) on page 122.
1.

If possible, back up all personal files.

2.

Insert the recovery USB flash drive you created into a USB port on your computer.

3.

Restart the computer and as soon as you see the HP logo screen, press f9 to display a list of boot
devices. Use the arrow keys to select your USB flash drive from the UEFI Boot Sources list. Press Enter
to boot from that device.

4.

Choose your keyboard layout.

5.

Select Troubleshoot.

6.

Select Refresh your PC.

7.

Follow the on-screen instructions.
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Recovery using Windows operating system media (purchased separately)
To order a Windows operating system DVD, contact support. Go to http://www.hp.com/support, select your
country or region, and follow the on-screen instructions.
CAUTION: Using Windows operating system media completely erases the hard drive contents and
reformats the hard drive. All files that you have created and any software that you have installed on the
computer are permanently removed. When reformatting is complete, the recovery process helps you restore
the operating system, as well as drivers, software, and utilities.
To initiate recovery using Windows operating system media:
NOTE: This process takes several minutes.
1.

If possible, back up all personal files.

2.

Restart the computer, and then follow the instructions provided with the Windows operating system
media to install the operating system.

3.

When prompted, press any keyboard key.

4.

Follow the on-screen instructions.

After the repair is completed and the Windows desktop appears:
1.

Remove the Windows operating system media, and then insert the Driver Recovery media.

2.

Install the Hardware Enabling Drivers first, and then install Recommended Applications.

Backing up, restoring, and recovering in Windows 7
Your computer includes tools provided by HP and Windows to help you safeguard your information
and retrieve it if you ever need to. These tools will help you return your computer to a proper working state
or even back to the original factory state, all with simple steps.
This section provides information about the following processes:
●

Creating recovery media and backups

●

Restoring and recovering your system

NOTE: This section describes an overview of backing up, restoring, and recovering options. For more details
about the Windows Backup and Restore tools provided, see Help and Support. To access Help and Support,
select Start > Help and Support.
Recovery after a system failure is only as good as your most recent backup.
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1.

After you successfully set up the computer, create recovery media. This media can be used to reinstall
the original operating system in cases where the hard drive is corrupted or has been replaced. See
Creating recovery media on page 123.

2.

As you add hardware and software programs, create system restore points. A system restore point is a
snapshot of certain hard drive contents saved by Windows System Restore at a specific time. A system
restore point contains information that Windows uses, such as registry settings. Windows creates a
system restore point for you automatically during a Windows update and during other system
maintenance (such as a software update, security scanning, or system diagnostics). You can also
manually create a system restore point at any time. For more information and steps for creating
specific system restore points, see Help and Support. To access Help and Support, select Start > Help
and Support.

3.

As you add photos, video, music, and other personal files, create a backup of your personal information.
If files are accidentally deleted from the hard drive and they can no longer be restored from the Recycle
Bin, or if files become corrupted, you can restore the files that you backed up. In case of system failure,
you can use the backup files to restore the contents of your computer. See Backing up your information
on page 125.

NOTE: HP recommends that you print the recovery procedures and save them for later use, in case of
system instability.

Creating recovery media
After you successfully set up the computer, create recovery media. The media can be used to reinstall the
original operating system in cases where the hard drive is corrupted or has been replaced.
There are two types of recovery media. To determine which steps to follow for your computer:
1.

Click the Start button.

2.

Click All Programs.
●

If Security and Protection is listed, continue with the steps in Creating recovery media using HP
Recovery Manager (select models only) on page 123.

●

If Productivity and Tools is listed, continue with the steps in Creating recovery discs with HP
Recovery Disc Creator (select models only) on page 124.

Creating recovery media using HP Recovery Manager (select models only)
●

To create recovery discs, your computer must have a DVD writer. Use DVD+R or DVD-R discs (purchased
separately). The discs you use will depend on the type of optical drive you are using.
NOTE:

DVD+R DL, DVD-R DL, or DVD±RW disc are not supported.

●

You have the option of creating a recovery USB flash drive instead, using a high-quality USB drive.

●

If you are creating recovery discs, be sure to use high-quality discs. It is normal for the system to reject
defective discs. You will be prompted to insert a new blank disc to try again.

●

The number of discs in the recovery-disc set depends on your computer model (typically 3 to 6 DVDs).
The Recovery Media Creation program tells you the specific number of blank discs needed to make the
set. If you are using a USB flash drive, the program will tell you the size of the drive required to store all
the data (minimum of 8 GB).
NOTE: The process of creating recovery media is lengthy. You can quit the process at any time. The
next time you initiate the process, it resumes where it left off.

Backing up, restoring, and recovering in Windows 7 123

NOTE: Do not use media cards for creating recovery media. The system may not be able to boot up from a
media card and you may not be able to run system recovery.
To create recovery discs:
1.

Close all open programs.

2.

Click the Start button, click All Programs, click Security and Protection, click Recovery Manager, and
then click HP Recovery Media Creation. If prompted, click Yes to allow the program to continue.

3.

Click Create recovery media using blank DVD(s), and then click Next.

4.

Follow the on-screen instructions. Label each disc after you make it (for example, Recovery 1, Recovery
2), and then store the discs in a secure place.

To create a recovery USB flash drive:
NOTE: You must use a USB flash drive with a capacity of at least 8 GB.
NOTE: Recovery Media Creation formats the USB flash drive, deleting any files on it.
1.

Close all open programs.

2.

Insert the USB flash drive into a USB port on the computer.

3.

Click the Start button, click All Programs, click Security and Protection, click Recovery Manager, and
then click Recovery Media Creation.

4.

Click Create recovery media with a USB flash drive, and then click Next.

5.

Select the USB flash drive from the list of media. The program will let you know how much storage is
required to create the recovery drive. If the USB flash drive does not have enough storage capacity, it
will appear grayed out, and you must replace it with a larger USB flash drive. Click Next.

6.

Follow the on-screen instructions. When the process is complete, label the USB flash drive and store it
in a secure place.

Creating recovery discs with HP Recovery Disc Creator (select models only)
HP Recovery Disc Creator is a software program that offers an alternative way to create recovery discs on
select models. After you successfully set up the computer, you can create recovery discs using HP Recovery
Disc Creator. The recovery discs allow you to reinstall your original operating system as well as select drivers
and applications if the hard drive becomes corrupted. HP Recovery Disc Creator creates two kinds of recovery
discs:
●

Windows 7 operating system DVD—Installs the operating system without additional drivers or
applications.

●

Driver Recovery DVD—Installs specific drivers and applications only, in the same way that the HP
Software Setup utility installs drivers and applications.

To create recovery discs, your computer must have a DVD writer. Use any of the following types of discs
(purchased separately): DVD+R, DVD+R DL, DVD-R, DVD-R DL, or DVD±RW. The discs you use will depend on
the type of optical drive you are using.
Creating recovery discs
NOTE: The Windows 7 operating system DVD can be created only once. The option to create that media will
not be available after you create a Windows DVD.
To create the Windows DVD:
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1.

Select Start > All Programs > Productivity and Tools > HP Recovery Disc Creator.

2.

Select Windows disk.

3.

From the drop-down menu, select the drive for burning the recovery media.

4.

Click the Create button to start the burning process. Label the disc after you create it, and store it in a
secure place.

After the Windows 7 operating system DVD has been created, create the Driver Recovery DVD:
1.

Select Start > All Programs > Productivity and Tools > HP Recovery Disc Creator.

2.

Select Driver disk.

3.

From the drop-down menu, select the drive for burning the recovery media.

4.

Click the Create button to start the burning process. Label the disc after you create it, and store it in a
secure place.

Backing up your information
You should create your initial backup immediately after initial system setup. As you add new software and
data files, you should continue to back up your system on a regular basis to maintain a reasonably current
backup. Your initial and subsequent backups allow you to restore your data and settings if a failure occurs.
You can back up your information to an optional external hard drive, a network drive, or discs.
Note the following when backing up:
●

Store personal files in the Documents library, and back it up regularly.

●

Back up templates that are stored in their associated directories.

●

Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot of your
settings. The screen shot can be a time-saver if you have to reset your preferences.

●

When backing up to discs, number each disc after removing it from the drive.

NOTE: For detailed instructions on various backup and restore options, perform a search for these topics in
Help and Support. To access Help and Support, select Start > Help and Support.
NOTE: You may be prompted by User Account Control for your permission or password when you perform
certain tasks. To continue a task, select the appropriate option. For information about User Account Control,
see Help and Support: Select Start > Help and Support.
To create a backup using Windows Backup and Restore:
NOTE: The backup process may take over an hour, depending on file size and the speed of the computer.
1.

Select Start > All Programs > Maintenance > Backup and Restore.

2.

Follow the on-screen instructions to set up your backup.

System Restore
If you have a problem that might be due to software that you installed on your computer, or if you want to
restore the system to a previous state without losing any personal information, use System Restore to return
the computer to a previous restore point.
NOTE: Always use this System Restore procedure before you use the System Recovery feature.
To start System Restore:
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1.

Close all open programs.

2.

Click the Start button, right-click Computer, and then click Properties.

3.

Click System protection, System Restore, click Next, and then follow the on-screen instructions.

System Recovery
WARNING! This procedure will delete all user information. To prevent loss of information, be sure to back
up all user information so you can restore it after recovery.
System Recovery completely erases and reformats the hard disk drive, deleting all data files that you have
created, and then reinstalls the operating system, programs, and drivers. However, you must reinstall any
software that was not installed on the computer at the factory. This includes software that came on media
included in the computer accessory box, and any software programs you installed after purchase. Any
personal files must be restored from backups you made.
If you were not able to create system recovery DVDs or USB flash drive, you can order a recovery disc set
from support. Go to http://www.hp.com/support, select your country or region, and follow the on-screen
instructions.
NOTE: Always use the System Restore procedure before you use the System Recovery program. See
System Restore on page 125.
You must choose one of the following methods to perform a System Recovery:
●

Recovery image — Run System Recovery from a recovery image stored on your hard disk drive. The
recovery image is a file that contains a copy of the original factory-shipped software. To perform a
System Recovery from a recovery image, see System Recovery when Windows is responding
on page 126 or System Recovery when Windows is not responding on page 127.

●

Recovery media — Run System Recovery from recovery media that you have created from files stored
on your hard disk drive or purchased separately. See System Recovery using recovery media (select
models only) on page 127.

System Recovery when Windows is responding
CAUTION: System Recovery deletes all data and programs you created or installed. Before you begin, back
up any important data to a CD or DVD or to a USB flash drive.
NOTE: In some cases, you must use recovery media for this procedure. If you have not already created this
media, follow the instructions in Creating recovery media on page 123.
If the computer is working and Windows 7 is responding, use these steps to perform a System Recovery:
1.

Turn off the computer.

2.

Disconnect all peripheral devices from the computer except the monitor, keyboard, and mouse.

3.

Turn on the computer.

4.

When Windows has loaded, click the Start button, and then click All Programs.

5.

●

If Security and Protection is listed, continue with step 5.

●

If Productivity and Tools is listed, follow the steps in System Recovery when Windows is not
responding on page 127.

Click Security and Protection, click Recovery Manager, and then click Recovery Manager. If prompted,
click Yes to allow the program to continue.
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6.

Under I need help immediately, click System Recovery.

7.

Select Yes, and then click Next. Your computer restarts.

8.

When the computer restarts, you will see the Recovery Manager welcome screen again. Under I need
help immediately, click System Recovery. If you are prompted to back up your files, and you have not
done so, select Back up your files first (recommended), and then click Next. Otherwise, select Recover
without backing up your files, and then click Next.

9.

System Recovery begins. After System Recovery is complete, click Finish to restart the computer.

10. When Windows has loaded, shut down the computer, reconnect all peripheral devices, and then turn the
computer back on.

System Recovery when Windows is not responding
CAUTION: System Recovery deletes all data and programs you created or installed.
If Windows is not responding, but the computer is working, follow these steps to perform a System Recovery.
1.

Turn off the computer. If necessary, press and hold the power button until the computer turns off.

2.

Disconnect all peripheral devices from the computer, except the monitor, keyboard, and mouse.

3.

Press the power button to turn on the computer.

4.

As soon as you see the HP logo screen, repeatedly press the F11 key on your keyboard until the
Windows is Loading Files… message appears on the screen.

5.

At the HP Recovery Manager screen, follow the on-screen instructions to continue.

6.

When Windows has loaded, shut down the computer, reconnect all peripheral devices, and then turn the
computer back on.

System Recovery using recovery media (select models only)
Use the steps provided in this section if you created recovery media using Creating recovery media using HP
Recovery Manager (select models only) on page 123. If you used HP Recovery Disc Creator to create a
Windows 7 operating system DVD and a Driver Recovery DVD, use the steps in Using HP Recovery Disc
operating system discs (select models only) on page 128.
CAUTION: System Recovery deletes all data and programs you have created or installed. Back up any
important data to a CD or DVD or to a USB flash drive.
To perform a System Recovery using recovery media:
1.

If you are using a set of DVDs, insert the first recovery disc into the DVD drive tray, and close the tray. If
you are using a recovery USB flash drive, insert it into a USB port.

2.

Click the Start button, and then click Shut Down.
or
If the computer is not responding, press and hold the power button for approximately 5 seconds or until
the computer turns off.

3.

Disconnect all peripheral devices from the computer except the monitor, keyboard, and mouse.

4.

Press the power button to turn on the computer, and press Esc as the computer is powering on to
display the startup menu.

5.

Use the arrow keys to select the boot menu, and press Enter. Use the arrow keys to select the location
where the recovery media is inserted (USB or DVD). Press Enter to boot from that device.
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6.

If Recovery Manager asks if you want to run System Recovery from Media or Hard Drive, select Media.
On the Welcome screen, under I need help immediately, click Factory Reset.

7.

If you are prompted to back up your files, and you have not done so, select Back up your files first
(recommended), and then click Next. Otherwise, select Recover without backing up your files, and
then click Next.

8.

If you are prompted to insert the next recovery disc, do so.

9.

When Recovery Manager is finished, remove the recovery disc or the recovery USB flash drive from the
system.

10. Click Finish to restart the computer.

Using HP Recovery Disc operating system discs (select models only)
Use the steps provided in this section if you used HP Recovery Disc Creator to create a Windows 7 operating
system DVD and a Driver Recovery DVD. If you created recovery media using Creating recovery media using
HP Recovery Manager (select models only) on page 123. use the steps in System Recovery using recovery
media (select models only) on page 127.
If you cannot use the recovery discs you previously created using the HP Recovery Disc Creator (select
models only), you must purchase a Windows 7 operating system DVD to reboot the computer and repair the
operating system.
To order a Windows 7 operating system DVD, contact support. Go to http://www.hp.com/support, select your
country or region, and follow the on-screen instructions.
CAUTION: Using a Windows 7 operating system DVD completely erases the hard drive contents and
reformats the hard drive. All files that you have created and any software that you have installed on the
computer are permanently removed. When reformatting is complete, the recovery process helps you restore
the operating system, as well as drivers, software, and utilities.
To initiate recovery using a Windows 7 operating system DVD:
NOTE: This process takes several minutes.
1.

If possible, back up all personal files.

2.

Restart the computer, and then insert the Windows 7 operating system DVD into the optical drive before
the Windows operating system loads.
NOTE: If the computer does not boot to the DVD, restart the computer and press Esc as the computer
is powering on to see the startup menu. Use the arrow keys to select the boot menu and press Enter.
Use the arrow keys to select the location where the recovery DVD is inserted. Press Enter to boot from
that device.

3.

When prompted, press any keyboard key.

4.

Follow the on-screen instructions.

5.

Click Next.

6.

Select Install now.

7.

Follow the on-screen instructions.
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After the repair is completed:
1.

Eject the Windows 7 operating system DVD and then insert the Driver Recovery DVD.

2.

Follow the on-screen instructions to install the Hardware Enabling Drivers first, and then install
Recommended Applications.
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A

Battery replacement
The battery that comes with the computer provides power to the real-time clock. When replacing the battery,
use a battery equivalent to the battery originally installed in the computer. The computer comes with a 3volt lithium coin cell battery.
WARNING! The computer contains an internal lithium manganese dioxide battery. There is a risk of fire and
burns if the battery is not handled properly. To reduce the risk of personal injury:
Do not attempt to recharge the battery.
Do not expose to temperatures higher than 60°C (140ºF).
Do not disassemble, crush, puncture, short external contacts, or dispose of in fire or water.
Replace the battery only with the HP spare designated for this product.
CAUTION: Before replacing the battery, it is important to back up the computer CMOS settings. When the
battery is removed or replaced, the CMOS settings will be cleared.
Static electricity can damage the electronic components of the computer or optional equipment. Before
beginning these procedures, ensure that you are discharged of static electricity by briefly touching a
grounded metal object.
NOTE: The lifetime of the lithium battery can be extended by plugging the computer into a live AC wall
socket. The lithium battery is only used when the computer is NOT connected to AC power.
HP encourages customers to recycle used electronic hardware, HP original print cartridges, and rechargeable
batteries. For more information about recycling programs, go to http://www.hp.com/recycle.
1.

Remove/disengage any security devices that prohibit opening the computer.

2.

Remove all removable media, such as compact discs or USB flash drives, from the computer.

3.

Turn off the computer properly through the operating system, then turn off any external devices.

4.

Disconnect the power cord from the power outlet and disconnect any external devices.
CAUTION: Regardless of the power-on state, voltage is always present on the system board as long as
the system is plugged into an active AC outlet. You must disconnect the power cord to avoid damage to
the internal components of the computer.

5.

Remove the access panel.

6.

Locate the battery and battery holder on the system board.
NOTE: On some computer models, it may be necessary to remove an internal component to gain
access to the battery.

7.

Depending on the type of battery holder on the system board, complete the following instructions to
replace the battery.
Type 1
a.

Lift the battery out of its holder.
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b.

Slide the replacement battery into position, positive side up. The battery holder automatically
secures the battery in the proper position.

Type 2
a.

To release the battery from its holder, squeeze the metal clamp that extends above one edge of
the battery. When the battery pops up, lift it out (1).

b.

To insert the new battery, slide one edge of the replacement battery under the holder’s lip with
the positive side up. Push the other edge down until the clamp snaps over the other edge of the
battery (2).

Type 3
a.

Pull back on the clip (1) that is holding the battery in place, and remove the battery (2).

b.

Insert the new battery and position the clip back into place.
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NOTE:

After the battery has been replaced, use the following steps to complete this procedure.

8.

Replace the access panel.

9.

Plug in the computer and turn on power to the computer.

10. Reset the date and time, your passwords, and any special system setups using Computer Setup.
11. Lock any security devices that were disengaged when the access panel was removed.
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Statement of Volatility
HP confirms that Intel-based business desktop HP ProDesk 400 G2 Small Form Factor systems contain DDR3
volatile memory (memory amount depends on the customer configuration). In addition, the motherboard in
the condition originally shipped without subsequent modification or the addition or installation of any
applications, features, or functionality, contains the following nonvolatile memory: Real Time Clock battery
backed-up configuration memory (256 Bytes), DIMM Serial Presence Detect (SPD) configuration data (256
Bytes per module, 128 Bytes programmable), Serial Peripheral Interface (SPI) ROM for System BIOS (16M
Bytes) and Super I/O’s: masked keyboard ROM (overall 2K Bytes).
HP ProDesk 400 G2 Small Form Factor models include a Trusted Platform Module (TPM) that contains 16K
Bytes of non-volatile memory for user data. The volatile memory will not hold any user data once power has
been removed for 30 seconds or longer.
The following procedure shows the steps that should be taken to restore the Non-Volatile memory found in
the Intel-based HP ProDesk 400 G2 Small Form Factor systems.
1.

Download the latest BIOS (system ROM) from the HP website.

2.

Follow the instructions to flash the BIOS that are found on the website.
Flashing the BIOS will reset it back to factory settings.

3.

Turn on the system, and while system is powering on, and after the HP splash screen, press the F10 key
to enter BIOS setup screen.

4.

Select Security > System Security from the main menu. If the Embedded Security Device Support
option is set to “Disable”, skip to step 7.

5.

To erase all security keys from the TPM:
Under Embedded Security Device in the System Security menu, configure Reset to Factory Settings to
Reset.
NOTE: Although the TPM security keys will be cleared, data in the non-volatile memory indices may
not be. Data stored in these indices should not contain security sensitive information. If an application
locks down and secures the non-volatile indices, these indices cannot be cleared.

6.

Press F10 to accept changes.

7.

To clear the secure boot key database:
a.

Enter the F10 setup utility.

b.

Go to the Security menu.

c.

Select Secure Boot Configuration.

d.

In the Key Management section, select clear Secure boot keys.

e.

Use space key to select clear.

f.

Press the F10 key to accept changes.

g.

From the main menu select File > Save Changes and Exit.

8.

If the Ownership Tag or Asset Tag is set, manually clear it under Security > System Ids.

9.

Select File > Save Changes and Exit.
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10. To clear the Setup or Power-On passwords if set, and clear any other settings, power down the
computer and remove the AC power cord and the computer hood.
11. Locate the green two pin password jumper on header E49 (labeled PSWD) and remove it.
12. Remove the AC power, wait 10 seconds until the unit AC power has drained out, then press the clear
CMOS button. This is typically a yellow push button (labeled CMOS).
13. Replace the hood and AC power cord and turn the computer on. The passwords are now cleared and all
other user-configurable, non-volatile memory settings are reset to their factory default values.
14. Enter the F10 setup utility.
15. Select File > Default Setup > Restore Factory Settings as Default. This will set the default settings
back to the factory defaults.
16. Select File > Apply Defaults and Exit.
17. Shut down the computer, remove the AC power cord and place the (blue/green) jumper back on header
E49. Replace the computer hood and power cord.
If Computrace is enabled on the computer, see the service provider for instruction to disable the feature.
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Power cord set requirements
The power supplies on some computers have external power switches. The voltage select switch feature on
the computer permits it to operate from any line voltage between 100-120 or 220-240 volts AC. Power
supplies on those computers that do not have external power switches are equipped with internal switches
that sense the incoming voltage and automatically switch to the proper voltage.
The power cord set received with the computer meets the requirements for use in the country where you
purchased the equipment.
Power cord sets for use in other countries must meet the requirements of the country where you use the
computer.

General requirements
The requirements listed below are applicable to all countries:
1.

The power cord must be approved by an acceptable accredited agency responsible for evaluation in the
country where the power cord set will be installed.

2.

The power cord set must have a minimum current capacity of 10A (7A Japan only) and a nominal
voltage rating of 125 or 250 volts AC, as required by each country’s power system.

3.

The diameter of the wire must be a minimum of 0.75 mm2 or 18AWG, and the length of the cord must be
between 1.8 m (6 feet) and 3.6 m (12 feet).

The power cord should be routed so that it is not likely to be walked on or pinched by items placed upon it or
against it. Particular attention should be paid to the plug, electrical outlet, and the point where the cord exits
from the product.
WARNING! Do not operate this product with a damaged power cord set. If the power cord set is damaged in
any manner, replace it immediately.

Japanese power cord requirements
For use in Japan, use only the power cord received with this product.
CAUTION: Do not use the power cord received with this product on any other products.

General requirements 135

Country-specific requirements
Additional requirements specific to a country are shown in parentheses and explained below.
Country

Accrediting Agency

Country

Accrediting Agency

Australia (1)

EANSW

Italy (1)

IMQ

Austria (1)

OVE

Japan (3)

METI

Belgium (1)

CEBC

Norway (1)

NEMKO

Canada (2)

CSA

Sweden (1)

SEMKO

Denmark (1)

DEMKO

Switzerland (1)

SEV

Finland (1)

SETI

United Kingdom (1)

BSI

France (1)

UTE

United States (2)

UL

Germany (1)

VDE

1.

The flexible cord must be Type HO5VV-F, 3-conductor, 0.75mm2 conductor size. Power cord set fittings (appliance coupler and
wall plug) must bear the certification mark of the agency responsible for evaluation in the country where it will be used.

2.

The flexible cord must be Type SVT or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole grounding type
with a NEMA 5-15P (15A, 125V) or NEMA 6-15P (15A, 250V) configuration.

3.

Appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the Japanese
Dentori Law. Flexible cord must be Type VCT or VCTF, 3-conductor, 0.75 mm2 conductor size. Wall plug must be a two-pole
grounding type with a Japanese Industrial Standard C8303 (7A, 125V) configuration.
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Specifications
Chassis (in the desktop position)
Height

3.93 in

100 mm

Width

13.26 in

33.7 cm

Depth

14.98 in

380 mm

Approximate Weight

13.0 lb

5.9 kg

Weight Supported (maximum distributed load in desktop position)

77 lb

35 kg

Operating

50° to 95°F

10° to 35°C

Nonoperating

-22° to 140°F

-30° to 60°C

Temperature Range

NOTE: Operating temperature is derated 1.0° C per 300 m (1000 ft) to 3000 m (10,000 ft) above sea level; no direct sustained
sunlight. Maximum rate of change is 10° C/Hr. The upper limit may be limited by the type and number of options installed.
Relative Humidity (noncondensing)
Operating

10-90%

10-90%

Nonoperating (38.7°C max wet bulb)

5-95%

5-95%

Operating

10,000 ft

3048 m

Nonoperating

30,000 ft

9144 m

Maximum Altitude (unpressurized)

Power Supply
Operating Voltage Range

90-264 VAC

Rated Voltage Range1

100-240 VAC

Rated Line Frequency

50-60 Hz

Operating Line Frequency

47-63 Hz

Standard Efficiency

240W active PFC

High Efficiency

240W active PFC
82/85/82% efficient at 20/50/100% load (230V)

Rated Input Current
1

4A

This system utilizes an active power factor corrected power supply. This allows the system to pass the CE mark requirements for use
in the countries of the European Union. The active power factor corrected power supply also has the added benefit of not requiring
an input voltage range select switch.
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